
J O I N T  A P P E L L A T E  T E C H N O L O G Y  S U B C O M M I T T E E

M I N U T E S  O F  O P E N  M E E T I N G
September 6, 2017 
4:00 PM – 5:00 PM 

Teleconference 

Advisory Body 
Members 
Present: 

Hon. Louis Mauro, Chair; Hon. Peter Siggins; Hon. Alan Perkins, Mr. 
Joseph Lane, Mr. Jorge Navarrete; Mr. Kevin Green, and Ms. Kimberly 
Stewart.    

Advisory Body 
Members 

Absent: 

Mr. Don Willenburg 

Others Present: Ms. Christy Simons, Ms. Heather Anderson 

O P E N  S E S S I O N

C A L L  T O  O R D E R  A N D  R O L L  C A L L

Justice Mauro called the meeting to order at 4:00 PM, and roll was called.  He noted there were 
no public comments received prior to this meeting.  

I T E M  1   Review of potential items for inclusion on proposed committee annual agenda 

Justice Mauro provided an update on the project to amend rule 8.144 to include formatting 
requirements for electronic reporters’ transcripts.  The proposed rule amendments circulated for 
public comment this spring and have been on hold pending AB 1450, the bill to amend Code of 
Civil Procedure section 271.  The bill is on track at the Legislature.  If signed, the new statute 
will take effect January 1, 2018. Rule amendments should take effect the same day.   

The subcommittee discussed other rules modernization projects that are on the current annual 
agenda as priority 2 items and decided to recommend retaining them on the next annual 
agenda: (1) rule amendments to address online access to appellate court records for parties, 
attorneys, local justice partners, and other government agencies; (2) rules for sealed and 
confidential material submitted electronically; (3) return of lodged electronic records; (4) 
bookmarking; and (5) electronic exhibits. 

Justice Mauro described the project to develop branch and model court privacy policies on 
electronic court records and access in the courts.  The ITAC Rules and Policy Subcommittee is 
taking the lead and is in the process of preparing an initial draft.  JATS will collaborate on the 
appellate portion. 

The project to amend rules to address online access to trial court records for parties, their 
attorneys, local justice partners, and other government agencies is underway.  JATS will review 
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what is ultimately proposed at the trial court level and use that to develop a companion proposal 
for access to appellate court records. 

The subcommittee decided to defer a suggested project on link rot to see how the Supreme 
Court’s new in-house solution works. 

The subcommittee discussed providing input on implementation of a new document 
management system in the appellate courts, and decided to monitor, provide input, and request 
regular reports going forward. 

The subcommittee discussed an article criticizing ImageSoft Truefiling, the system used by the 
California appellate courts for electronic filing, which raised the issue of whether there is 
adequate oversight of the system, including the information it provides to its customers and the 
fees it charges.  The subcommittee concluded that Information Services should take the lead on 
providing oversight; the subcommittee will monitor. 

 
A D J O U R N M E N T  

The meeting was adjourned at 4:51 PM 
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J O I N T  A P P E L L A T E  T E C H N O L O G Y  S U B C O M M I T T E E  
M I N U T E S  O F  O P E N  M E E T I N G  

February 5, 2018 
12:00–1:00 PM 
Teleconference 

Advisory Body 
Members 
Present: 

Hon. Louis Mauro, Chair; Mr. Kevin Green, Mr. Jorge Navarrete, Hon. 
Alan Perkins, Ms. Beth Robbins, Mr. Timothy Schooley, and Mr. Don 
Willenburg.    

Advisory Body 
Members 

Absent: 

Hon. Peter Siggins  

Others Present:  Ms. Heather Anderson, Ms. Ingrid Leverett, Mr. Patrick O'Donnell, and 
Ms. Christy Simons  

O P E N  S E S S I O N  

Call to Order and Roll Call  
Justice Mauro called the meeting to order at 12:00 PM, and roll was called. He noted there were 
no public comments received prior to this meeting.  
 
Ms. Simons introduced Ms. Leverett, who is working on the Sealed and Confidential Materials 
project. 
 
Item 1  
Electronic Exhibits (Discussion)  
The subcommittee reviewed potential amendments to rule 8.74 to include rules for bookmarking 
electronic exhibits and for submitting electronic exhibits in volumes.  Justice Mauro suggested 
that, rather than carving out rules for exhibits, it may be time to consider rules for the format of 
electronic documents generally.  Members agreed that electronic filing is well-established in the 
appellate courts and uniform formatting rules would be beneficial.  The subcommittee agrees 
with redefining the project as developing format requirements for electronic documents.   
 
Action:  The subcommittee voted to recommend deferring further action on the exhibits 
proposal. 
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Item 2 
Sealed and Confidential Materials (Discussion)  
The subcommittee reviewed potential amendments to rules 8.46 and 8.47 to harmonize these 
rules with parallel trial court rules governing sealed records, make these appellate rules 
internally consistent, and provide for the disposition of lodged records submitted electronically. 
 
Action:  The subcommittee voted to recommend to AAC and ITAC that they seek approval to 
circulate the proposal for public comment. 
 
Item 3  
Branch and Model Court Privacy Policies on Electronic Court Records and Access in the 
Appellate Courts (Discussion)  
The Information Technology Advisory Committee (ITAC) is developing a Privacy Resource 
Guide (PRG). This guide is designed to assist the trial and appellate courts in protecting the 
privacy interests of members of the public who become involved with the California Court 
system while providing the public with reasonable access to court records. JATS members are 
asked to review and comment on several draft sections of the guide and to direct comments to 
Mr. O’Donnell or Mr. Willenburg. 
 
A D J O U R N M E N T  

The meeting was adjourned at 1:00 PM. 
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A P P E L L A T E  A D V I S O R Y  C O M M I T T E E / I N F O R M A T I O N  T E C H N O L O G Y  
A D V I S O R Y  C O M M I T T E E  

J O I N T  A P P E L L A T E  T E C H N O L O G Y  S U B C O M M I T T E E  

M I N U T E S  O F  O P E N  M E E T I N G  

July 2, 2018 
4:00 p.m. 

Teleconference 

Advisory Body 
Members Present: 

Hon. Louis Mauro, chair, Mr. Kevin Green, Mr. Jorge Navarrete, Hon. Alan 
Perkins, Ms. Beth Robbins, Mr. Tim Schooley, Hon. Peter Siggins, Mr. Don 
Willenburg 

Advisory Body 
Members Absent: 

N/A 

Others Present:  Ms. Christy Simons, Ms. Jessica Craven, Ms. Ingrid Leverett, Ms. Kristi Morioka 

O P E N  M E E T I N G   

Call to Order and Roll Call  
The chair called the meeting to order at 4:00 p.m., and roll was taken. 

D I S C U S S I O N  A N D  A C T I O N  I T E M S  

Item 1 

Sealed and Confidential Materials 
The subcommittee reviewed public comments on the proposal to amend rules 8.45, 8.46, and 
8.47.  Two child support organizations commented that new subdivision (e) of rule 8.46 could be 
interpreted as expanding appellate jurisdiction and suggested adding language to clarify that this 
was not the intent.  The subcommittee noted that the language of a rule cannot expand the 
availability of appellate review, but agreed to add an advisory committee comment to address the 
issue. 
 
Action: The subcommittee approved the proposal as modified. 

A D J O U R N M E N T  

There being no further business, the meeting was adjourned at 4:10 p.m. 
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Approved by the advisory body on enter date. 
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J O I N T  A P P E L L A T E  T E C H N O L O G Y  S U B C O M M I T T E E  
M I N U T E S  O F  O P E N  M E E T I N G  

August 30, 2018 
4:00–5:00 PM 

Teleconference 

Advisory Body 
Members 
Present: 

Hon. Louis Mauro, Chair; Mr. Kevin Green, Mr. Jorge Navarrete, Hon. 
Alan Perkins, Ms. Beth Robbins, Mr. Timothy Schooley, Hon. Peter 
Siggins and Mr. Don Willenburg.    

Advisory Body 
Members 

Absent: 

None. 

Others Present:  Ms. Christy Simons and Ms. Kristi Morioka 
  

O P E N  S E S S I O N  
C A L L  T O  O R D E R  A N D  R O L L  C A L L   
 
Justice Mauro called the meeting to order at 4:00 PM, and roll was called. He noted that no 
public comments were received. 
 
I T E M  1   Review of potential items for inclusion in the committees’ annual agendas 
 
The subcommittee reviewed suggestions regarding appellate technology projects for the 2018-
2019 annual agendas of the Appellate Advisory Committee and the Information Technology 
Advisory Committee. 
 
Action:  The subcommittee decided on its recommendations to the committees about which 
suggestions should be considered and potentially worked on, and their prioritization.. 

 
A D J O U R N M E N T  

The meeting was adjourned at 4:51 PM. 
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JUDICIAL COUNCIL OF CALIFORNIA  

455 Golden Gate Avenue . San Francisco, California 94102-3688 

www.courts.ca.gov/policyadmin-invitationstocomment.htm 
 

 
This proposal has not been approved by the Judicial Council and is not intended to represent the views of 

the council, its Rules and Projects Committee, or its Policy Coordination and Liaison Committee. 
It is circulated for comment purposes only. 

 

I N V I T A T I O N  T O  C O M M E N T  
SPR19-__ 

Title 

Appellate Procedure: Service Copy of a 
Petition for Review 

Proposed Rules, Forms, Standards, or Statutes 

Amend Cal. Rules of Court, rule 8.500 

Proposed by 

Appellate Advisory Committee 
Hon. Louis R. Mauro, Chair 
 
Information Technology Advisory Committee 
Hon. Sheila F. Hanson, Chair 

 Action Requested 

Review and submit comments by June 7, 2019 

Proposed Effective Date 

January 1, 2020 

Contact 

Kristi Morioka 
916-643-7056  
kristi.morioka@jud.ca.gov 

 

Executive Summary 

To update court procedures and provide clarity, the Appellate Advisory Committee and the 
Information Technology Advisory Committee propose amending the rule regarding petitions for 
review in the California Supreme Court to remove the requirement to send to the Court of 
Appeal a separate service copy of an electronically filed petition for review.  Under current 
practice, when a petition for review is accepted for electronic filing by the Supreme Court, the 
Court of Appeal automatically receives a filed/endorsed copy of the petition through the 
electronic filing service provider (EFSP).  Thus, in actual practice, the electronic filing of a 
petition satisfies the requirement to serve the Court of Appeal, and there is no need for a 
petitioner to serve the Court of Appeal with another copy as required by the rules. This proposal 
does not change the requirement to serve the Court of Appeal with a separate copy if a petition 
for review is filed in paper form. This project originated from a suggestion submitted by an 
appellate court administrator.   

Background 

Rule 8.500 governs petitions for review in the Supreme Court.  Subdivision (f)(1) of this rule 
provides that “[t]he petition must also be served on the superior court clerk and the 
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clerk/executive officer of the Court of Appeal.”1 This requirement has existed in the rule since it 
was adopted as rule 28 on January 1, 2003.2 
 
However, pursuant to rule 8.71 and rules 3 and 4 of the Supreme Court Rules Regarding 
Electronic Filing, electronic filing in the Supreme Court is now mandatory for parties 
represented by counsel and voluntary for self-represented litigants and trial courts. As a result, a 
large majority of petitions for rehearing are now filed electronically.  
 
Notably, the Supreme Court has recognized the redundancy of requiring separate service on the 
Court of Appeal of an electronically filed petition. On its web page, the Supreme Court provides 
this advisement: 
 

Notwithstanding the requirements set forth in California Rules of Court, Rule 8.500(f)(1), 
submission of a petition for review through TrueFiling that is accepted for filing by the 
Supreme Court constitutes service of the petition on the Court of Appeal. 

The Proposal 

This proposal would clarify that when a petition for review is filed electronically, the filer does 
not need to serve a separate copy on the Court of Appeal.  When a petition for review is filed in 
paper, however, the clerk/executive officer of the Court of Appeal must still be served.   
 
This proposal is intended to eliminate duplicative and unnecessary effort by counsel, self-
represented litigants, and appellate court staff.  The current EFSP automatically sends a copy of 
the petition for review to the clerk/executive officer of the Court of Appeal when it is filed 
electronically.  But the rules require the filer to serve the clerk/executive officer of the Court of 
Appeal.  This causes additional effort and expense for the filer and additional workload for the 
clerk/executive officer of the Court of Appeal.   
 
[Staff note: If the Supreme Court contracts with a different EFSP in the future and/or protocols 
change, is there a possibility that the Court of Appeal would no longer automatically receive a 
copy of an electronically filed petition for review?  Staff is attempting to get more information on 
this point.] 
 
The committee proposes amending rule 8.500(f)(1) as follows: 
 

The petition must also be served on the superior court clerk and, if filed in paper format, 
the clerk/executive officer of the Court of Appeal. Electronic filing of a petition 
constitutes service of the petition on the clerk/executive officer of the Court of Appeal. 

                                                 
1 An advisory committee comment clarifies that the service requirement applies only to the petition, not to an answer 
or a reply. 
2 Rule 28 was renumbered as rule 8.500 in 2007. 
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Alternatives Considered 

The committee considered maintaining the current requirements that parties serve the Courts of 
Appeal separately.  The committee concluded that these rule changes are appropriate because 
they eliminate unnecessary and duplicative effort and expense.  

Fiscal and Operational Impacts 

This proposal should not have appreciable implementation costs and should save court resources 
by eliminating duplicate electronic filings.    
 

Request for Specific Comments 

In addition to comments on the proposal as a whole, the committees are interested in 
comments on the following: 

 Does the proposal appropriately address the stated purpose? 
 Should the proposal address the possibility of the Supreme Court contracting with a 

different EFSP in the future? 
 
The committees also seek comments from courts on the following cost and implementation 
matters: 

 Would the proposal provide cost savings?  If so, please quantify. 
 What would the implementation requirements be for courts—for example, training 

staff (please identify position and expected hours of training), revising processes and 
procedures (please describe), changing docket codes in case management systems, or 
modifying case management systems? 

 Would three months from Judicial Council approval of this proposal until its effective 
date provide sufficient time for implementation? 

 How well would this proposal work in courts of different sizes? 
 

Attachments and Links 

1. Cal. Rules of Court, rule 8.550, at p. 4 
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Title 8. Appellate Rules 1 
 2 

Division 1. Rules Relating to the Supreme Court and Courts of Appeal 3 
 4 

Chapter 9. Proceedings in the Supreme Court 5 
 6 
 7 
Rule 8.500.  Petition for review 8 
 9 
(a) – (e)  * * * 10 
 11 
(f) Additional requirements  12 
 13 

(1) The petition must also be served on the superior court clerk and, if filed in 14 
paper format, the clerk/executive officer of the Court of Appeal. 15 
Electronic filing of a petition constitutes service of the petition on the 16 
clerk/executive officer of the Court of Appeal. 17 

 18 
 19 
(2) A copy of each brief must be served on a public officer or agency when 20 

required by statute or by rule 8.29.  21 
 22 
(3) The clerk/executive officer of the Supreme Court must file the petition 23 

even if its proof of service is defective, but if the petitioner fails to file a 24 
corrected proof of service within 5 days after the clerk gives notice of the 25 
defect the court may strike the petition or impose a lesser sanction.  26 

 27 
(g)  * * * 28 
 29 

Advisory Committee Comment 30 
 31 

Subdivision (a). * * * 32 
 33 
Subdivision (e). * * * 34 
 35 
Subdivision (f). The general requirements relating to service of documents in the appellate courts 36 
are established by rule 8.25. Subdivision (f)(1) requires that the petition (but not an answer or 37 
reply) be served on the clerk/executive officer of the Court of Appeal. To assist litigants, (f)(1) 38 
also states explicitly what is impliedly required by rule 8.212(c), i.e., that the petition must also 39 
be served on the superior court clerk (for delivery to the trial judge).  40 
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JUDICIAL COUNCIL OF CALIFORNIA 

2860 Gateway Oaks Drive, Suite 400 . Sacramento, California 95833-4336 

Telephone 916-263-7885 . Fax 916-263-1966 . TDD 415-865-4272 

 
 

M E M O R A N D U M  
  

 

Date 
January 23, 2019 
 

To 
Hon. Louis Mauro, Chair 
Joint Appellate Technology 
Subcommittee 
 

From 
Kristi Morioka, Attorney 
Legal Services, Judicial Council 
 

Subject 
Rules modernization: Uniform 
formatting rules for electronic 
documents 
 
Amendments to California Rules of 
Court, rules 8.40, 8.44, 8.71, 8.72, 
8.74 and 8.252. 

Action Requested 
Please Review 
 

Deadline 
January 28, 2019 
 

Contact 
Kristi Morioka 
916-643-7056 phone 
kristi.morioka@jud.ca.gov 

 

Introduction 

On August 30, 2018, the Joint Appellate Technology Subcommittee (JATS) of 
the Information Technology Advisory Committee (ITAC) and the Appellate 
Advisory Committee (AAC) met and considered potential topics for proposals 
to be developed during the 2019 rules cycle.  In a prior cycle, certain projects 
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Hon. Louis Mauro 
January 23, 2019 
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had been suggested for rules regarding exhibits and bookmarking of 
electronic documents, but JATS members realized those projects identified a 
larger need.  All appellate courts had implemented e-filing, but local rules for 
the format of electronic documents differed among the appellate courts, 
resulting in burdens for court users.  JATS decided to develop uniform format 
rules for electronic documents filed in the appellate courts.   

Background 

The state appellate courts implemented electronic filing at different times.  
As each court went live with electronic filing, they adopted their own set of 
local rules addressing the format requirements for electronic documents.  
While there is overlap among the local rules, the rules also differ in various 
respects.  Over the years, best practices have begun to emerge for the format 
of electronic documents.  At the same time, court users have complained that 
the differing format rules among the appellate courts impose significant 
burdens on practice. 
 
A more limited rules amendment project began in 2017, but was deferred and 
expanded.  The current project seeks adoption of rule amendments that are 
proposed to be effective on January 1, 2020.  The proposed amendments 
include both substantive and technical changes to the existing rules 
consistent with the recommended best practices for the format of electronic 
documents in appellate courts.  Uniform format rules would provide 
consistency, clarity and efficiency. 
 
Most of the proposed changes are to rule 8.74.  That rule currently sets forth 
responsibilities of electronic filers but also establishes certain minimum 
format requirements for electronic documents.  The recommendation is to 
move the filer responsibility provisions out of rule 8.74 and add them with 
the court responsibility provisions in rule 8.72, and to significantly expand 
the format provisions in rule 8.74.  As expanded, rule 8.74 would establish 
the specific format requirements currently articulated in local rules, such as 
standards for cover pages, pagination, and bookmarks. 
 
The California Rules of Court proposed to be amended are as follows: 
 
8.40 Form of filed documents,  
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8.44 Number of copies of filed documents,  
8.71 Electronic filing,  
8.72 Responsibilities of court,  
8.74 Responsibilities of electronic filer, and 
8.252 Judicial notice, filings and evidence on appeal. 

The Proposal 
Rule 8.40.  Form of filed documents  
Rule 8.40 describes the form for filed documents.  The current rule explains 
that filed documents may be produced on a computer or be typewritten.  The 
rule also referenced certain format requirements that do not apply to 
electronic documents. 
 
The proposed amendments would create different subdivisions for electronic 
and paper documents, would reference the format rules applicable to those 
different types of documents, and would clarify that certain format 
requirements in rule 8.40 only apply to paper.  The proposal does not change 
the format requirements for paper documents.  The proposal updates the rule 
to reflect that e-filing is mandatory unless an exemption applies. 

Rule 8.44.  Number of copies of filed documents 
Rule 8.44 sets forth the rules for paper copies in the California Supreme 
Court and the Courts of Appeal.  But rule 8.44(c) pertains to electronic copies.  
Among other things, it refers to a court that “permits” electronic filing, and it 
requires a local rule specifying the format of an electronic copy.  Because e-
filing is now mandatory and the format of electronic documents is addressed 
in proposed rule 8.74, the proposal deletes those outdated references. 

Rule 8.71.  Electronic filing 
Rule 8.71 imposes mandatory e-filing, but it allows for various exemptions, 
including those established by local rule.  The proposal would delete the 
reference to exemption by local rule, except that it would reference the 
California Supreme Court’s local rules.  That reference would allow the 
California Supreme Court’s Local Rules, rule 3, which specifies which 
documents must be electronically filed in the Supreme Court.  Although this 
proposal would delete the general reference to exemption by local rule in an 
effort to promote uniformity, nothing in these rules expressly prohibits local 
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rules regarding e-filing or the format of electronic documents.  The 
subcommittee may wish to discuss whether such an express prohibition 
would be appropriate or desirable. 
 
In an effort to reduce cross-references, the proposal does not list other 
applicable exemptions.  The subcommittee may wish to discuss whether 
cross-references are desirable. 

Rule 8.72.  Responsibilities of the court 
Rule 8.72 sets forth the e-filing responsibilities of a court.  The proposal takes 
the provisions for the responsibilities of electronic filers from current rule 
8.74 and moves them to rule 8.72 in a new subdivision (b), thereby combining 
the responsibilities of court and filer into a single rule, and leaving rule 8.74 
to address format. 
 
Staff recommends deleting current rule subdivisions 8.72(b)(1) and (b)(2) as 
no longer needed.  The subcommittee should discuss this recommendation. 

Rule 8.74.  Responsibilities of electronic filer 
Rule 8.74(a) establishes the responsibilities of an electronic filer.  As 
previously discussed, this proposal moves the content of subdivision (a) to 
rule 8.72.  Staff cross-checked the rules to ensure that the subdivision is not 
cross-referenced in another rule. 
 
Rule 8.74(b) authorizes appellate courts to establish requirements for 
electronic documents, but it sets forth certain minimum format standards 
such as text-searchability.  The proposal retains some of the existing 
language, moves it to a new proposed subdivision (a), and significantly 
expands the format requirements by drawing from the best practices among 
the appellate courts.  The expanded format rules address topics such as 
bookmarking, protection of sensitive information, file size, manual filing, 
font, spacing, margins, hyperlinks and color.  The proposal also adds a new 
subdivision (c) to address specific format requirements for briefs, requests for 
judicial notice, proofs of service, appendices, agreed statements and settled 
statements, reporter’s transcripts, clerk’s transcripts and exhibits.  
 
Proposed rule 8.74(a)(1) references portable document format (PDF).  PDF is 
a file format used to present and exchange documents reliably, independent 
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of software, hardware or operating system.  Invented by Adobe, PDF is now 
an open standard maintained by the International Organization for 
Standardization (ISO).  Existing California Supreme Court and Court of 
Appeal local rules require documents to be in “text-searchable PDF.”  To 
ensure text searchability, the proposal requires a filer to “convert” a paper 
document to electronic form, rather than scanning or printing the document. 
 
The rules for pagination in proposed subdivision (a)(2) are consistent with the 
local rule pagination requirements around the state.  
 
Proposed subdivision (a)(3) indicates that these format rules prevail over 
conflicting format rules.  The proposal does not attempt to identify conflicting 
format rules.  
 
Proposed subdivision (a)(4) defines an electronic bookmark.  A more generic 
definition would describe an electronic bookmark as an identifier placed in a 
document so that part of the document can be easily accessed, but the 
proposal seeks to be more descriptive to assist electronic filers. 
 
Proposed subdivision (a)(6) sets a file-size limit of 25 megabytes.  The 25-
megabyte limit is the current capacity of the Appellate Court Case 
Management System (ACCMS). 
 
Proposed subdivision (a)(7) describes manual filing of oversized documents or 
documents that otherwise cannot be electronically filed.  The proposal 
permits the filer to file a flash drive, DVD or compact disc (CD) with the court 
and then give notice of the filing, but the Court of Appeal, Second Appellate 
District currently requires the filer to ask permission before such a filing.  
The subcommittee may wish to discuss this alternative. 
 
The term DVD is considered sufficiently descriptive that it is not spelled out, 
but the term CD is spelled out for clarity.  The file types for video, audio and 
photographs are based on local rules and the current capacity at the courts.  
Subcommittee members may wish to discuss whether other file types should 
be referenced. 
 
Proposed subdivision (a)(8) describes the font type and font size for electronic 
documents.  It specifies a serif face such as Century School Book.  The 
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suggestion comes from the Court of Appeal, Second Appellate District’s local 
rule, which seeks to promote readability.  This memorandum is formatted in 
Century Schoolbook, size 13 font, consistent with the proposed rule. 
 
A “serif” is the little decorative line found in fonts such as Times New Roman 
and Georgia.  “Sans serif” means “without the decorative line.”  Sans serif 
fonts include Arial, Calibri, Century Gothic, Helvetica, Tahoma and Verdana. 
 
The subcommittee may disagree with the Court of Appeal, Second Appellate 
District’s recommendation of a serif font.  According to some experts, serif 
fonts are more readable in paper form while sans serif fonts are more 
readable in electronic form.  Fonts that are very elaborate or ornate can be 
difficult to read because the letter shapes are not well-defined.  They also 
may not comply with accessibility requirements under the Americans with 
Disabilities Act. 
 
Proposed subdivision (a)(14) specifies that a document with any color 
component must be manually filed rather than electronically filed.  This is 
because color causes problems in ACCMS.  The subdivision prohibits color 
components in electronically filed documents.   
 
Proposed rule 8.74(b) addresses specific format requirements for certain 
documents.  Subdivision (b)(3) refers to proofs of service and the proposed 
language reflects the practice in the Court of Appeal, Third Appellate 
District, although other Courts of Appeal may do things differently.  The 
subcommittee should discuss whether a proof of service should be filed as a 
part of the referenced document or whether it should be filed separately. 
 
Proposed rule 8.74(b) does not repeat the general format rules when 
discussing the specific documents. 

Rule 8.252.  Judicial notice; filings and evidence on appeal 
Rule 8.252 establishes the procedure for seeking judicial notice of a matter.  
The proposal requires the moving party to attach to the motion a copy of the 
matter to be noticed or an explanation why it is not practicable to do so.  The 
pagination rules in rule 8.74 would apply to the motion with attachments. 
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Proposed rule 8.252(c)(3) is reorganized to reflect the presumption of 
electronic filing unless an exemption applies.  

Additional Proposal Considerations 

This memorandum lays out items for discussion and decision by the 
subcommittee.  The invitation to comment will include an opportunity for the 
advisory committees to request specific comments about the proposal.   

Subcommittee’s Tasks 

Discuss the draft proposal and whether the subcommittee wishes to pose 
questions in a request for specific comments. 
 
The following rules were reviewed and it was determined that no further 
amendments were needed at this time, but the subcommittee may wish to 
confirm this for themselves: 
  
Rules: 
8.124 Appendixes,  
8.144 Form of the record, 
8.204 Contents and form of briefs, and  
8.212 Service and filing of briefs. 
 
Determine the draft proposal language that should be included in the 
proposal.  

Next Steps 

Based on the subcommittee’s direction and edits on the proposal language, 
staff will prepare an invitation to comment (ITC) and proposal and submit 
them as follows: 
 
(1) to AAC to vote on circulating the proposal for public comment at their 

meeting on February 21, 2019; 
(2) to ITAC to vote on circulating the proposal for public comment at an ad 

hoc meeting date to be determined in the future; and 
(3) to the Judicial Council Editing and Graphics Group for copyediting. 
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Hon. Louis Mauro 
January 23, 2019 
Page 8 

Attachments and Links  
1. California Rules of Court, rules 8.40, 8.44, 8.71, 8.72, 8.74, and 8.252, at pp. 9-25.
2. Appellate court local rules pertaining to electronic documents, at pp. 26-205.
3. California Rules of Court, rule 8.40 Form of filed documents,

http://www.courts.ca.gov/cms/rules/index.cfm?title=eight&linkid=rule8_40
4. California Rules of Court, rule 8.44 Number of copies of filed documents, 

http://www.courts.ca.gov/cms/rules/index.cfm?title=eight&linkid=rule8_44
5. California Rules of Court, rule 8.71 Electronic filing,

http://www.courts.ca.gov/cms/rules/index.cfm?title=eight&linkid=rule8_71
6. California Rules of Court, rule 8.72 Responsibilities of court,

http://www.courts.ca.gov/cms/rules/index.cfm?title=eight&linkid=rule8_72
7. California Rules of Court, rule 8.74 Responsibilities of electronic filer, 

http://www.courts.ca.gov/cms/rules/index.cfm?title=eight&linkid=rule8_74
8. California Rules of Court, rule 8.252 Judicial notice, filings and evidence on 

appeal,
http://www.courts.ca.gov/cms/rules/index.cfm?title=eight&linkid=rule8_252

9. California Rules of Court, rule 8.124 Appendixes,
http://www.courts.ca.gov/cms/rules/index.cfm?title=eight&linkid=rule8_124

10. California Rules of Court, rule 8.144 Form of the record,
http://www.courts.ca.gov/cms/rules/index.cfm?title=eight&linkid=rule8_144

11. California Rules of Court, rule 8.204 Contents and form of briefs,
http://www.courts.ca.gov/cms/rules/index.cfm?title=eight&linkid=rule8_204

12. California Rules of Court, rule 8.212 Service and filing of briefs,
http://www.courts.ca.gov/cms/rules/index.cfm?title=eight&linkid=rule8_212
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Title 8.  Appellate Rules  1 
 2 

Division 1.  Rules Relating to the Supreme Court and Courts of Appeal 3 
 4 

Chapter 1.  General Provisions 5 
 6 

Article 2.  Service, Filing, Filing Fees, Form, and Privacy 7 
 8 
 9 
Rule 8.40.  Form of filed documents 10 
 11 
(a) Form of Electronic Documents 12 
 13 
Except as these rules provide otherwise, documents filed in a reviewing court may be 14 
either produced on a computer or typewritten and must comply with the relevant 15 
provisions of rule 8.204(b). 16 
 17 

Pursuant to rules 8.70(c)(2)(D), 8.70 (c)(8), and 8.71(a), a document filed in a 18 
reviewing court must be in electronic form unless these rules provide otherwise.  19 
An electronic document must comply with the relevant format provisions of this 20 
rule and rules 8.74, 8.144 and 8.204. 21 

 22 
(b) Cover color 23 
(b) Form of Paper Documents 24 
 25 

To the extent these rules authorize the filing of a paper document in a reviewing 26 
court, the document must comply with the relevant format provisions of this rule 27 
and rules 8.144 and 8.204. 28 
 29 

(c) Cover color of paper briefs and petitions  30 
 31 

(1) As far as practicable, the covers of briefs and petitions filed in paper form 32 
must be in the following colors: 33 

 34 

Appellant's opening brief 
or appendix 

green 

Respondent's brief or 
appendix 

yellow 

Appellant's reply brief or 
appendix 

tan 
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Joint appendix white 

Amicus curiae brief gray 

Answer to amicus curiae 
brief 

blue 

Petition for rehearing orange 

Answer to petition for 
rehearing 

blue 

Petition for original writ red 

Answer (or opposition) to 
petition for original writ 

red 

Reply to answer (or 
opposition) to petition for 
original writ 

red 

Petition for transfer of 
appellate division case to 
Court of Appeal 

white 

Answer to petition for 
transfer of appellate 
division case to Court of 
Appeal 

blue 

Petition for review white 

Answer to petition for 
review 

blue 

Reply to answer to 
petition for review 

white 

Opening brief on the 
merits 

white 

Answer brief on the 
merits 

blue 
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Reply brief on the merits white 

 1 
(2) In appeals under rule 8.216, the cover of a combined respondent's brief and 2 

appellant's opening brief filed in paper form must be yellow, and the cover 3 
of a combined reply brief and respondent's brief filed in paper form must be 4 
tan. 5 

 6 
(3) A paper brief or petition not conforming to (1) or (2) must be accepted for 7 

filing, but in case of repeated violations by an attorney or party the court 8 
may proceed as provided in rule 8.204(e)(2). 9 

 10 
 (c) Cover information 11 
(d) Cover information for electronic and paper documents 12 
 13 

(1) Except as provided in (2), the cover-or first page if there is no cover-of 14 
every document filed in a reviewing court must include the name, mailing 15 
address, telephone number, fax number (if available), e-mail address (if 16 
available), and California State Bar number of each attorney filing or joining 17 
in the document, or of the party if he or she is unrepresented. The inclusion 18 
of a fax number or e-mail address on any document does not constitute 19 
consent to service by fax or e-mail unless otherwise provided by law. 20 

 21 
(2) If more than one attorney from a law firm, corporation, or public law office 22 

is representing one party and is joining in the document, the name and State 23 
Bar number of each attorney joining in the document must be provided on 24 
the cover. The law firm, corporation, or public law office representing each 25 
party must designate one attorney to receive notices and other 26 
communication in the case from the court by placing an asterisk before that 27 
attorney's name on the cover and must provide the contact information 28 
specified under (1) for that attorney. Contact information for the other 29 
attorneys from the same law firm, corporation, or public law office is not 30 
required but may be provided. 31 

 32 
(3) The covers of electronic documents must also comply with the provisions of 33 

rule 8.74. 34 
 35 

  36 
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Title 8.  Appellate Rules  1 
 2 

Division 1.  Rules Relating to the Supreme Court and Courts of Appeal 3 
 4 

Chapter 1.  General Provisions 5 
 6 

Article 2.  Service, Filing, Filing Fees, Form, and Privacy  7 
 8 
 9 
Rule 8.44.  Number of copies of filed documents 10 
 11 
(a) Documents filed in the Supreme Court 12 
 13 

Except as these rules provide otherwise, the number of copies of every brief, 14 
petition, motion, application, or other document that must be filed in the Supreme 15 
Court and that is filed in paper form is as follows: 16 

 17 
(1) An original of a petition for review, an answer, a reply, a brief on the merits, 18 

an amicus curiae brief, an answer to an amicus curiae brief, a petition for 19 
rehearing, or an answer to a petition for rehearing and either 20 

 21 
(A) 13 paper copies; or 22 
 23 
(B) 8 paper copies and one electronic copy; 24 

 25 
(2) Unless the court orders otherwise, an original of a petition for a writ within 26 

the court's original jurisdiction, an opposition or other response to the 27 
petition, or a reply; and either: 28 

 29 
(A) 10 paper copies; or 30 
 31 
(B) 8 paper copies and one electronic copy; 32 

 33 
(3) Unless the court orders otherwise, an original and 2 copies of any supporting 34 

document accompanying a petition for writ of habeas corpus, an opposition 35 
or other response to the petition, or a reply; 36 

 37 
(4) An original and 8 copies of a petition for review to exhaust state remedies 38 

under rule 8.508, an answer, or a reply, or an amicus curiae letter under rule 39 
8.500(g); 40 

 41 
(5) An original and 8 copies of a motion or an opposition or other response to a 42 

motion; and 43 
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 1 
(6) An original and 1 copy of an application, including an application to extend 2 

time, or any other document. 3 
 4 
(b) Documents filed in a Court of Appeal 5 
 6 

Except as these rules provide otherwise, the number of copies of every brief, 7 
petition, motion, application, or other document that must be filed in a Court of 8 
Appeal and that is filed in paper form is as follows: 9 

 10 
(1) An original and 4 paper copies of a brief, an amicus curiae brief, or an 11 

answer to an amicus curiae brief. In civil appeals, for briefs other than 12 
petitions for rehearing or answers thereto, 1 electronic copy or, in case of 13 
undue hardship, proof of delivery of 4 paper copies to the Supreme Court, as 14 
provided in rule 8.212(c) is also required; 15 

 16 
(2) An original of a petition for writ of habeas corpus filed under rule 8.380 by 17 

a person who is not represented by an attorney and 1 set of any supporting 18 
documents; 19 

 20 
(3) An original and 4 copies of any other petition, an answer, opposition or 21 

other response to a petition, or a reply; 22 
 23 
(4) Unless the court orders otherwise, an original and 1 copy of a motion or an 24 

opposition or other response to a motion; 25 
 26 
(5) Unless the court provides otherwise by local rule or order, 1 set of any 27 

separately bound supporting documents accompanying a document filed 28 
under (3) or (4); 29 

 30 
(6) An original and 1 copy of an application, other than an application to extend 31 

time, or any other document; and 32 
 33 
(7) An original and 1 copy of an application to extend time. In addition, 1 copy 34 

for each separately represented and unrepresented party must be provided to 35 
the court. 36 

 37 
(c) Electronic copies 38 
 39 

A court that permits electronic filing will specify any requirements regarding 40 
electronically filed documents in the electronic filing requirements published under 41 
rule 8.74. In addition, a A court may provide by local rule for the submission of an 42 
electronic copy of a document that is not electronically filed either in addition to the 43 
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copies of a document required to be filed under (a) or (b) or as a substitute for one 1 
or more of these copies. The local rule must specify the format of the electronic 2 
copy and provide for an exception if it would cause undue hardship for a party to 3 
submit an electronic copy. 4 
 5 

  6 
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Title 8.  Appellate Rules  1 
 2 

Division 1.  Rules Relating to the Supreme Court and Courts of Appeal 3 
 4 

Chapter 1.  General Provisions 5 
 6 

Article 5.  E-filing 7 
 8 
 9 
Rule 8.71.  Electronic filing 10 
 11 
(a) Mandatory electronic filing 12 
 13 

Except as otherwise provided by these rules, the Supreme Court Rules Regarding 14 
Electronic Filing, the local rules of the reviewing court, or by court order, all parties 15 
are required to file all documents electronically in the reviewing court. 16 

 17 
(b) Self-represented parties 18 
 19 

(1) Self-represented parties are exempt from the requirement to file documents 20 
electronically. 21 

 22 
(2) A self-represented party may agree to file documents electronically. By 23 

electronically filing any document with the court, a self-represented party 24 
agrees to file documents electronically. 25 

 26 
(3) In cases involving both represented and self-represented parties, represented 27 

parties are required to file documents electronically; however, in these 28 
cases, each self-represented party may file documents in paper form. 29 

 30 
(c) Trial courts 31 
 32 

Trial courts are exempt from the requirement to file documents electronically, but 33 
are permitted to file documents electronically. 34 

 35 
(d) Excuse for undue hardship or significant prejudice 36 
 37 

A party must be excused from the requirement to file documents electronically if 38 
the party shows undue hardship or significant prejudice. A court must have a 39 
process for parties, including represented parties, to apply for relief and a procedure 40 
for parties excused from filing documents electronically to file them in paper form. 41 

 42 
(e) Applications for fee waivers 43 
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 1 
The court may permit electronic filing of an application for waiver of court fees and 2 
costs in any proceeding in which the court accepts electronic filings. 3 

 4 
(f) Effect of document filed electronically 5 
 6 

(1) A document that the court, a party, or a trial court files electronically under 7 
the rules in this article has the same legal effect as a document in paper 8 
form. 9 

 10 
(2) Filing a document electronically does not alter any filing deadline. 11 

 12 
(g) Paper documents 13 
 14 

When it is not feasible for a party to convert a document to electronic form by 15 
scanning, imaging, or another means, the court may allow that party to file the 16 
document in paper form. 17 

 18 
  19 
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Title 8.  Appellate Rules  1 
 2 

Division 1. Rules Relating to the Supreme Court and Courts of Appeal 3 
 4 

Chapter 1.  General Provisions 5 
 6 

Article 5.  E-filing 7 
 8 
 9 
Rule 8.72.  Responsibilities of court and electronic filer 10 
 11 
(a) Responsibilities of court Publication of electronic filing requirements 12 
 13 

(1) Publication of electronic filing requirements 14 
 15 

The court will publish, in both electronic and print formats, the court's electronic 16 
filing requirements. 17 

 18 
(b) (2) Problems with electronic filing 19 

 20 
If the court is aware of a problem that impedes or precludes electronic filing, it must 21 
promptly take reasonable steps to provide notice of the problem. 22 

 23 
(b) Responsibilities of electronic filer 24 
 25 

Each electronic filer must: 26 
 27 

(1) Comply with any court requirements designed to ensure the integrity of 28 
electronic filing and to protect sensitive personal information; 29 

 30 
(2) Furnish information that the court requires for case processing; 31 
 32 
(3)(1) Take all reasonable steps to ensure that the filing does not contain computer 33 

code, including viruses, that might be harmful to the court's electronic filing 34 
system and to other users of that system; 35 

 36 
(4)(2) Furnish one or more electronic service addresses, in the manner specified by 37 

the court, at which the electronic filer agrees to accept service; and 38 
 39 
(5)(3) Immediately provide the court and all parties with any change to the 40 

electronic filer's electronic service address. 41 
  42 
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Title 8.  Appellate Rules  1 
 2 

Division 1. Rules Relating to the Supreme Court and Courts of Appeal 3 
 4 

Chapter 1.  General Provisions 5 
 6 

Article 5.  E-filing 7 
 8 
 9 
Rule 8.74. Responsibilities of electronic filer Format of electronic documents 10 
 11 
(a) Conditions of filing 12 
 13 
Each electronic filer must: 14 
 15 
(1) Comply with any court requirements designed to ensure the integrity of electronic 16 
filing and to protect sensitive personal information; 17 
 18 
(2) Furnish information that the court requires for case processing; 19 
 20 
(3) Take all reasonable steps to ensure that the filing does not contain computer code, 21 
including viruses, that might be harmful to the court's electronic filing system and to 22 
other users of that system; 23 
 24 
(4) Furnish one or more electronic service addresses, in the manner specified by the 25 
court, at which the electronic filer agrees to accept service; and 26 
 27 
(5) Immediately provide the court and all parties with any change to the electronic filer's 28 
electronic service address. 29 
 30 
(Subd (a) amended effective January 1, 2011.) 31 
 32 
(b) Format of documents to be filed electronically 33 
 34 
(1) A document that is filed electronically with the court must be in a format specified by 35 
the court unless it cannot be created in that format. 36 
 37 
(2) The format adopted by a court must meet the following minimum requirements: 38 
 39 
(A) The format must be text-searchable while maintaining original document formatting. 40 
 41 
(B) The software for creating and reading documents must be in the public domain or 42 
generally available at a reasonable cost. 43 
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(C) The printing of documents must not result in the loss of document text, format, or 1 
appearance. 2 
 3 
(3) The page numbering of a document filed electronically must begin with the first page 4 
or cover page as page 1 and use only Arabic numerals (e.g., 1, 2, 3). The page number 5 
may be suppressed and need not appear on the cover page. 6 
 7 
(4) If a document is filed electronically under the rules in this article and cannot be 8 
formatted to be consistent with a formatting rule elsewhere in the California Rules of 9 
Court, the rules in this article prevail. 10 
 11 
(Subd (b) amended effective January 1, 2017.) 12 
 13 
Rule 8.74 amended and renumbered effective January 1, 2017; adopted as rule 8.76 14 
effective July 1, 2010; previously amended effective January 1, 2011. 15 
 16 
(a) Format requirements applicable to all electronic documents  17 
 18 

(1) Text-searchable portable document format.  Electronic documents must be 19 
in text-searchable portable document format (PDF), or other searchable 20 
format approved by the court, while maintaining original document 21 
formatting.  An electronic filer is not required to use a specific vendor, 22 
technology, or software for creation of a searchable format document, unless 23 
the electronic filer agrees to such use. The software for creating and reading 24 
electronic documents must be in the public domain or generally available at 25 
a reasonable cost.  If an electronic filer must file a document that the 26 
electronic filer possesses only in paper format, the electronic filer must 27 
convert the document to an electronic document by a means that complies 28 
with this rule.  The printing of an electronic document must not result in the 29 
loss of document text, format, or appearance.  It is the electronic filer's 30 
responsibility to ensure that any document filed is complete and readable. 31 

 32 
(2) Pagination.  The page numbering of a document filed electronically must 33 

begin with the first page or cover page as page 1 and use only Arabic 34 
numerals (e.g., 1, 2, 3).  Documents may not contain more than one 35 
numbering system; they may not contain Roman numerals for the table of 36 
contents and Arabic numerals for the body of the document.  The electronic 37 
page counter for the electronic document must match the page number for 38 
each page of the document.  The page number for the cover page may be 39 
suppressed and need not appear on the cover page.  When a document is 40 
filed in both paper and electronic formats, the pagination in both versions 41 
must comply with this subparagraph. 42 

 43 
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(3) This rule prevails over other formatting rules.  If a document is filed 1 
electronically and cannot be formatted to be consistent with a formatting 2 
provision elsewhere in the California Rules of Court, the provisions of this 3 
rule prevail. 4 

 5 
(4) Bookmarking.  An electronic bookmark is a descriptive text link that 6 

appears in the bookmarks panel of an electronic document.  Each electronic 7 
document must include an electronic bookmark to each heading, 8 
subheading, and to the first page of any component of the document, 9 
including but not limited to any table of contents, table of authorities, 10 
petition, verification, points and authorities, declaration, certificate of word 11 
count, certificate of interested entities or persons, proof of service, tab, 12 
exhibit, or attachment.  Each electronic bookmark must describe the item to 13 
which it is linked.  For example, an electronic bookmark to a heading must 14 
provide the text of the heading, and an electronic bookmark to a tab, exhibit, 15 
or attachment must include the letter or number of the tab, exhibit, or 16 
attachment and a description of the tab, exhibit, or attachment.  An 17 
electronic appendix must have bookmarks to the indexes and to the first 18 
page of each separate exhibit or attachment.  Tabs, exhibits, or attachments 19 
within a tab, exhibit, or attachment must be bookmarked.  All bookmarks 20 
must be set to "Inherit Zoom" to retain the reader's selected zoom setting. 21 

 22 
(5) Protection of sensitive information.  Electronic filers must comply with rules 23 

1.201, 8.45, 8.46, 8.47, and 8.401, regarding the protection of sensitive 24 
information, except for those requirements exclusively applicable to paper 25 
format. 26 

 27 
(6) Size and multiple files.  An electronic filing may not be larger than 25 28 

megabytes.  This rule does not change the limitations on word count or 29 
number of pages otherwise established by the California Rules of Court for 30 
documents filed in the court.  If a document exceeds the 25-megabyte file-31 
size limitation, the electronic filer must submit the document in more than 32 
one file, with each file 25 megabytes or less.  The first file must include a 33 
master chronological and alphabetical index stating the contents for all files.  34 
Each file must have a cover page setting forth (a) the file number for that 35 
file, (b) the total number of files for that document, (c) the page numbers 36 
contained in that file, and (d) the total number of pages for that document.  37 
(Example:  File 1 of 4, pp. 1-299 of 1198.)  In addition, each file must be 38 
paginated consecutively across all files in the document, including the cover 39 
pages for each file.  (For example, if the first file ends on page 300, the 40 
cover of the second file must be page 301.)  If a multiple-file document is 41 
submitted to the court in both electronic and paper formats, the cover pages 42 
for each file must be included in the paper documents. 43 
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 1 
(7) Manual Filing. 2 

 3 
(A) When an electronic filer seeks to file an electronic document 4 

consisting of more than five files, or when the document cannot or 5 
should not be electronically filed in multiple files, or when 6 
electronically filing the document would cause undue hardship, the 7 
document must not be electronically filed but must be manually filed 8 
with the court on electronic media such as a flash drive, DVD or 9 
compact disc (CD).  When an electronic filer files one or more 10 
documents on electronic media such as a flash drive, DVD or CD 11 
with the court, the electronic filer must electronically file, on the 12 
same day, a “manual filing notification” notifying the court and the 13 
parties that one or more documents have been filed on electronic 14 
media, explaining the reason for the manual filing.  The electronic 15 
media must be served on the parties in accordance with the 16 
requirements for service of paper documents.  To the extent 17 
practicable, each document or file on the electronic media must 18 
comply with the format requirements of this rule. 19 

 20 
(B) Electronic media files such as audio, video, or PowerPoint, and 21 

documents containing photographs or any color component, must be 22 
manually filed.  Audio files must be filed in .wav or mp3 format. 23 
Video files must be filed in .avi or mp4 format.  Photographs must 24 
be filed in .jpg or .pdf format. 25 

 26 
(8) Font.  The font style must be a proportionally spaced serif face, such as 27 

Century School Book.  Do not use Times New Roman.  Font size must be 28 
13 point, including in footnotes. 29 

 30 
(9) Spacing.  Line spacing must be set at 1.5.  Footnotes and quotations may be 31 

set at 1.0. 32 
 33 
(10) Margins.  The margins must be set at 1.5 inches on all sides. 34 
 35 
(11) Alignment.  Paragraphs must be left-aligned, not justified. 36 
 37 
(12) Hyperlinks.  Hyperlinks are encouraged but not required.  However, if an 38 

electronic filer elects to include hyperlinks in a document, the hyperlink 39 
must be active as of the date of filing and should be formatted to standard 40 
citation format as provided in the California Rules of Court. 41 

 42 
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(13) Tabs.  Documents must include tabs to the extent required by the California 1 
Rules of Court.  A tab must be a separate page identifying the content 2 
following the tab (such as a page stating “Exhibit A”). 3 

 4 
(14) No color. Notwithstanding provisions to the contrary in the California Rules 5 

of Court, an electronic document with any color component may not be 6 
electronically filed. It must be manually filed on electronic media.  An 7 
electronically filed document must not have color covers, color signatures, 8 
or other color components absent leave of court.  This requirement does not 9 
apply to the auto-color feature of hyperlinks. 10 

 11 
(b) Additional format requirements for certain electronic documents 12 
 13 

(1) Brief.  An electronic brief must comply with the requirements set forth in 14 
rule 8.204, except for the requirements exclusively applicable to paper 15 
format including the provisions in rule 8.204(b)(2), (3), (4), (5), and (6).  16 
This rule sets forth the font, spacing, and margin requirements for electronic 17 
documents. 18 

 19 
(2) Request for judicial notice or request to add documents to the appellate 20 

record.  When seeking judicial notice or when seeking to add documents to 21 
the appellate record, the electronic filer must attach the documents to be 22 
noticed or added to the request.  The request with attachments must comply 23 
with this rule. 24 

 25 
(3) Proof of service.  An electronic filer must file the proof of service for a 26 

document as a separate document.   27 
 28 
(4) Appendix.  The format of an appendix must comply with this rule and rule 29 

8.144 pertaining to clerk's transcripts.   30 
 31 
(5) Agreed statement and settled statement.  The format for an agreed statement 32 

or a settled statement must comply with this rule and rules 8.144 and 33 
8.124(d). 34 

 35 
(6) Reporter's transcript and clerk's transcript.  The format for an electronic 36 

reporter's transcript must comply with Code of Civil Procedure section 271 37 
and rule 8.144.  The format for an electronic clerk's transcript must comply 38 
with this rule and rule 8.144. 39 

 40 
(7) Exhibits.  Electronic exhibits must be submitted in volumes of no more than 41 

300 pages and less than 25 megabytes, rather than as individual documents. 42 
   43 
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(c) Rejection of an electronic filing for noncompliance; exemptions 1 
 2 

The court will reject an electronic filing if it does not comply with the requirements 3 
of this rule.  However, if the requirements of this rule cause undue hardship or 4 
significant prejudice to any electronic filer, the electronic filer may file a motion for 5 
an exemption from the requirements of this rule.  6 
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Title 8.  Appellate Rules  1 
 2 

Division 1. Rules Relating to the Supreme Court and Courts of Appeal 3 
 4 

Chapter 2.  Civil Appeals 5 
 6 

Article 4. Hearing and Decision in the Court of Appeal 7 
 8 
 9 
Rule 8.252.  Judicial notice; findings and evidence on appeal 10 
 11 
(a) Judicial notice 12 
 13 

(1) To obtain judicial notice by a reviewing court under Evidence Code section 14 
459, a party must serve and file a separate motion with a proposed order. 15 

 16 
(2) The motion must state: 17 
 18 

(A) Why the matter to be noticed is relevant to the appeal; 19 
 20 
(B) Whether the matter to be noticed was presented to the trial court and, 21 

if so, whether judicial notice was taken by that court; 22 
 23 
(C) If judicial notice of the matter was not taken by the trial court, why 24 

the matter is subject to judicial notice under Evidence Code section 25 
451, 452, or 453; and 26 

 27 
(D) Whether the matter to be noticed relates to proceedings occurring 28 

after the order or judgment that is the subject of the appeal. 29 
 30 
(3) If the matter to be noticed is not in the record, the party must attach to the 31 

motion a copy of the matter to be noticed or an explanation a copy with the 32 
motion or explain why it is not practicable to do so. The pages of the copy 33 
of the matter or matters to be judicially noticed must be consecutively 34 
numbered, beginning with the number 1. The motion with attachments must 35 
comply with rule 8.74 if filed in electronic form. 36 

 37 
(b) Findings on appeal 38 
 39 

A party may move that the reviewing court make findings under Code of Civil 40 
Procedure section 909. The motion must include proposed findings. 41 

 42 
(c) Evidence on appeal 43 
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 1 
(1) A party may move that the reviewing court take evidence. 2 
 3 
(2) An order granting the motion must: 4 
 5 

(A) State the issues on which evidence will be taken; 6 
 7 
(B) Specify whether the court, a justice, or a special master or referee 8 

will take the evidence; and 9 
 10 
(C) Give notice of the time and place for taking the evidence. 11 

 12 
(3) For documentary evidence, a party may offer the original, a certified copy, a 13 

photocopy, or, in a case in which electronic filing is permitted, an electronic 14 
copy., or if filed in paper form, the original, a certified copy, or a photocopy. 15 
The court may admit the document in evidence without a hearing. 16 
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LOCAL RULES OF THE COURT OF APPEAL 
FIRST APPELLATE DISTRICT 

 
Published pursuant to California Rules of Court, rule 10.1030 

 
As amended effective May 1, 2015 

 
Rule 16.  Electronic Filing  
 
 Pursuant to California Rules of Court, rule 8.70, the Court will require all filings 
in this District, effective March 17, 2014, for all civil filings and effective April 14, 2014, 
for all criminal and juvenile filings, to be made through the Court’s electronic filing 
system (EFS) operated by ImageSoft TrueFiling (TrueFiling).  Use of the EFS system is 
mandatory for all attorneys filing in this District, unless an exemption is granted, and is 
voluntary for all self-represented litigants.  A filing in electronic format will be accepted 
in lieu of any paper copies otherwise required under California Rules of Court, rule 8.44 
and constitutes the official record of the Court. 
 
 (a)  [Registration] 
 

 (1)  Obligation to Register.  Each attorney of record in any proceeding in 
this District is obligated to become an EFS user and obtain a user ID and password 
for access to the TrueFiling system.  Self-represented litigants must register if they 
wish to e-file.  Attorneys and self-represented litigants may register at:  
<https://www.truefiling.com/_layouts/ElectronicFile.Main/SignUp.aspx> 
 
 (2)  Obligation to Keep Account Information Current.  An EFS user is 
responsible for all documents filed under the user’s registered ID and password.  
Registered users are required to keep their e-mail address current and may update 
their e-mail address online via the TrueFiling Web site. 
 
(b)  [Format] 
 
 (1)  Documents filed electronically must be in PDF format, or readily 
capable of conversion to PDF format while maintaining original document 
formatting by TrueFiling to permit text searches and to facilitate transmission and 
retrieval. If the filer possesses only a paper copy of a document, it may be scanned 
to convert it to a searchable PDF format. It is the filer's responsibility to ensure 
that any document filed is complete and readable. No single document shall 
exceed a total file size of 25 MB. 
 
 (2)  Electronic briefs must comply with the content and form requirements 
of California Rules of Court, rule 8.204, with the exception of those provisions 
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dealing exclusively with requirements for paper.  Electronic bookmarks to each 
topic heading in the text (as listed in the table of contents) in briefs are 
recommended, and required for all briefs exceeding forty (40) pages. 
 
 (3)  Motions and Original Proceedings.  All motions and original 
proceedings must include electronic bookmarks to each section heading in the text 
(as listed in the table of contents), and to the first page of any exhibit(s), with the 
exhibit number or letter and a description of the exhibit included in the bookmark. 
 
 Pleadings and exhibits not properly formatted may be rejected. 

 
 (c)  [Signatures]  A TrueFiling user ID and password is the equivalent of an 
electronic signature for a registered attorney or party.  Any document displaying the 
symbol “/s/” with the attorney’s or party’s printed name shall be deemed signed by that 
attorney/party. 

 
 (d)  [Trial Court Record] 
 

 (1)  Appendices, Agreed Statements, and Settled Statements.  Parties must 
submit any appendix filed pursuant to California Rules of Court, rule 8.124, any 
agreed statement filed pursuant to California Rules of Court, rule 8.134, or any 
settled statement filed pursuant to California Rules of Court, rule 8.137 in 
electronic form. Appendices exceeding ten volumes may be delivered to the court 
on machine readable optical media in lieu of e-filing.  Each part of the record 
submitted in any appendix or exhibit volume shall clearly state the volume and 
page numbers included within that part and include an index of contents, with a 
descriptive electronic bookmark including exhibit number or letter, to the first 
page of each indexed document (e.g., Exhibit 1 – First Amended Complaint). 
 
 (2)  Administrative Records.  In addition to any administrative record 
provided by the trial court pursuant to California Rules of Court, rule 8.123, the 
party or parties seeking review must submit a copy of the administrative record in 
electronic form.  An administrative record may be delivered to the court on 
machine readable optical media in lieu of e-filing. 
 
 (3)  Reporter’s Transcripts.  Any party who orders a reporter’s transcript of 
proceedings pursuant to California Rules of Court, rule 8.130 must also request a 
copy of the transcript in computer-readable format, as provided in California Rules 
of Court, rule 8.130(f)(4), and submit an electronic copy to the Court. 
 
 Should the record of trial court proceedings exceed the TrueFiling size 
limitations, a party must either (a) submit the record in multiple parts, or 
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(b) provide the Court with the record in digital format on machine readable optical 
media. 
 
 (4)  Submissions by the Trial Court.  The trial court is encouraged, but is 
not required to, submit the clerk’s transcript and/or the reporter’s transcript(s) in 
searchable PDF format, either through the TrueFiling system or a court provided 
portal, in lieu of paper copies otherwise required under the California Rules of 
Court, and to make electronic versions available to parties willing to accept them 
in lieu of paper copies.  Digital copies of clerk’s transcripts and reporter’s 
transcripts must comply with the content and form requirements set forth in the 
California Rules of Court with the exception of those provisions dealing 
exclusively with requirements for paper. 
 

 (e)  [Personal Identifiers and Privacy Issues]  To protect personal privacy, 
parties and their attorneys must not include, or must redact where inclusion is necessary, 
personal identifiers such as social security numbers, driver’s license numbers, and 
financial account numbers from all pleadings and other papers filed in the Court’s public 
file, whether filed in paper or electronic form, unless otherwise provided by law or 
ordered by the Court.  (California Rules of Court, rule 1.20(b).)  If an individual’s social 
security number is required in a pleading or other paper filed in the public file, only the 
last four digits of that number shall be used.  If financial account numbers are required in 
a pleading or other paper filed in the public file, only the last four digits of these numbers 
shall be used.  Particularly sensitive confidential information such as medical records and 
proprietary or trade secret information should be filed only under seal as required by law 
or authorized pursuant to the California Rules of Court. 
 
 The responsibility for excluding or redacting identifiers from all documents filed 
with the Court rests solely with the parties and their attorneys.  (California Rules of 
Court, rule 1.20(b)(3).)  Neither TrueFiling nor the Clerk of the Court has any 
responsibility to review pleadings or other papers for compliance. 
 
 (f)  [Filing Deadlines]  Filing documents electronically does not alter any filing 
deadlines.  In order to be timely filed on the day they are due, all electronic transmissions 
of documents must be completed (i.e., received completely by the Clerk of the Court) 
prior to midnight.  Where a specific time of day is set for filing by Court order or 
stipulation, the electronic filing shall be completed by that time.  Although EFS permits 
parties to submit documents electronically 24 hours a day, users should be aware that 
telephone or online assistance may not be available outside of normal Court business 
hours. 
 
 (g)  [Completion of Filing]  Electronic transmission of a document through 
TrueFiling in compliance with the California Rules of Court shall, upon confirmed 
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receipt of the entire document by the Clerk of the Court, constitute filing of the document 
for all purposes. 
 
 (h)  [Technical Failure/Motions for Late Filing]  If a filer fails to meet a filing 
deadline imposed by Court order, rule, or statute because of a failure at any point in the 
electronic transmission and receipt of a document, the filer may file the document on 
paper or electronically as soon thereafter as practicable and accompany the filing with a 
motion to accept the document as timely filed.  For good cause shown, the Court may 
enter an order permitting the document to be filed nunc pro tunc to the date the filer 
originally sought to transmit the document electronically. 
 
 The Clerk of the Court shall deem the EFS system to be subject to a technical 
failure whenever the system is unable to accept filings continuously or intermittently over 
the course of any period of time greater than one hour after 12:00 noon that day.  Filings 
due on the day of a technical failure which were not filed solely due to such technical 
failure shall be due the next court day.  Such delayed filings shall be accompanied by a 
declaration or affidavit attesting to at least two attempts by the filer to file electronically 
after 12:00 noon with each attempt at least one hour apart on each day of delay due to 
such technical failure.  The initial point of contact for any practitioner experiencing 
difficulty filing a document into the EFS system shall be the toll-free number posted on 
the TrueFiling Web site. 
 
 The Court shall not be responsible for malfunction or errors occurring in electronic 
transmission or receipt of electronically filed documents. 
 
 (i)  [Manual Filing]  An EFS user may be excused from filing a particular 
document electronically if (1) it is not available in electronic format; (2) it must therefore 
be scanned to PDF; and (3) the file size of the scanned document exceeds the limit 
specified on the EFS Web site.  Such a document instead shall be manually filed with the 
Clerk of Court and served upon the parties in accordance with the statutory requirements 
and the California Rules of Court applicable to service of paper documents.  Parties 
manually filing a document shall file electronically a manual filing notification setting 
forth the reason why the document cannot be filed electronically. 
 
 (j)  [Service]  An attorney’s registration with TrueFiling to participate in EFS 
constitutes consent to service or delivery of all documents by any other party in a case 
through the system.  (California Rules of Court, rule 8.71.)  Orders or other documents 
generated by the Court will be served only through the EFS or by e-mailed notification.  
Only self-represented litigants who are not registered EFS users will receive manual 
service or notification by other means. 
 
 (k)  [Filing fees]  TrueFiling is a private vendor under contract with the Court.  
TrueFiling will assess vendor fees for each filing in accordance with the schedule posted 
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on its Web site, as approved by the Court.  E-filing fees will be considered recoverable 
costs under California Rules of Court, rule 8.278(d)(1)(D).  TrueFiling is designated as 
the Court’s agent for collection of Court imposed fees where required for any filing, and 
any associated credit card or bank charges or convenience fees (California Rules of 
Court, rule 8.78; Gov. Code, § 6159). 
 
 Self-represented parties are exempt from the requirement of electronic filing.  
However, should a self-represented party with a fee waiver opt to file documents 
electronically, that party is exempt from the fees and costs associated with electronic 
filing.  The persons and entities identified in Government Code section 6103 also are 
exempt from the fees and costs associated with e-filing. 
 
 (l)  [Exemptions]  Self-represented parties may, but are not required to register for 
electronic filing, but must comply with this rule and the requirements of TrueFiling if 
they elect to register. 
 
 If this rule causes undue hardship or significant prejudice to any party, the party 
shall lodge the number of paper copies required by the California Rules of Court without 
regard to electronic filing, plus an additional unbound paper copy in lieu of the electronic 
copy, accompanied by a declaration setting forth facts that support the claim of hardship.  
Acceptance of the lodged papers for filing will be subject to further order of the Court.  
When it is not otherwise feasible for a party to convert a document to electronic form by 
scanning, imaging or other means, the document may be filed in paper form (California 
Rules of Court, rule 8.73(c)), together with a declaration setting forth the reasons that 
electronic filing was not feasible. 
 
 (m)  [Sanctions for Noncompliance]  Failure of counsel to timely register or 
otherwise comply with EFS filing requirements, unless exempted, shall subject counsel to 
sanctions as may be imposed by the Court. 
 
 (n)  [Posting and Publication]  The Clerk of the Court is directed to post a copy 
of this rule on the Court’s Web site pursuant to California Rules of Court, rule 8.74(a), 
and to submit a copy to the Reporter of Decisions for publication pursuant to California 
Rules of Court, rule 10.1030(a). 

JATS MATERIALS E-BINDER PAGE 41



Formatting Guidelines 

The Court encourages all electronic filers to comply with the following 
guidelines for briefs, motions, appendices, writ petitions and other documents 
filed in connection with appeals or original proceedings. 

Pagination: 
Number pages consecutively beginning with the cover page of the 
document, using only the Arabic numbering system, as in 1, 2, 3. Do 
not use a separate pagination system for tables within the document. 
The page number does not need to appear on the cover page. 

Bookmarks: 

Briefs, motions and petitions: In any document that contains a table 
of contents, the table should include an electronic bookmark for each 
heading to the corresponding heading in the text. 
A bookmark is a text link that appears in the Bookmarks Panel of 
Adobe Reader and Adobe Acrobat. In this example, clicking on 
“INTRODUCTION” would take the reader to that part of the brief. 

 

Appendices and exhibits: In any document that contains an index, 
including appendices and exhibits in support of writ petitions, the 
index should include an electronic bookmark from each descriptive 
document title to the first page of the corresponding document in 
the appendix or exhibits. 

Where appendices or exhibits are submitted in multi-part electronic 
files, each separate file should have a table or index stating the 
contents of that file. The table or index should include the 
bookmarks as noted above. 
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Revised 6/18/2018  

Electronic Formatting Requirements and Guidelines 

of the Second District 

Pursuant to California Rules of Court 

rules 8.72(a) and 8.74(b) 

 

Effective October 30, 2017 

Revised June 18, 2018 

 

Formatting Requirements 

 

1. Text-searchable format 

All documents must be text-searchable, in PDF 

(portable document format) while maintaining the 

original document formatting. 

 

2. Cover Page 

The upper-right corner of the cover page must be left blank in 

order for TrueFiling to apply a visible file stamp. 

 

3. Pagination 

The page numbering of a document filed electronically must 

begin with the first page or cover as page 1 and use only 

Arabic numerals (e.g., 1, 2, 3). Documents consisting of 

multiple files must be paginated consecutively across all 

files.  The Adobe Page Counter number must match the 

consecutive page numbering. 

 

4. Electronic Bookmarks 

All briefs, original proceedings, motions and applications 

with attachments must include electronic bookmarks to each 

heading, subheading and component of the document. This 

includes such items as the table of contents, table of 

authorities, petition, verification, points and authorities, 

declaration, certificate of word count, certificate of interested 

entities or persons, and proof of service. Each bookmark to a 

tab, exhibit, or attachment must include the letter or number 
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Revised 6/18/2018  

of the tab, exhibit or attachment and a description of the tab, 

exhibit or attachment. The required setting for all 

bookmarks is “Inherit Zoom” which retains the user’s 

currently selected zoom setting. 

Any appendix filed electronically must have a separate 

electronic bookmark to the indexes and to the first page of 

each separate exhibit and attachment. Exhibits or 

attachments included within an exhibit or attachment must 

be separately bookmarked. 

 

5. Size 

No single PDF file may exceed 25 megabytes. Notwithstanding 

provisions to the contrary in the California Rules of Court, 

electronically filed documents may exceed the 300 page limit as 

long as the file size is 25 megabytes or smaller.  If submitting 

multiple files in TrueFiling would cause undue hardship, any 

registered user may file an application in TrueFiling, requesting 

permission to provide the court with the filing in electronic format 

(e.g. on a flash drive, or alternatively on CD or DVD), explaining 

the reason for the manual filing.  

 

Please note, audio and/or video files are not accepted through 

TrueFiling at this time and must be delivered to the Clerk’s Office 

on a DVD, CD or flash drive. In addition, audio files must be 

submitted in .wav or mp3 format and video files must be submitted 

in .avi or mp4 format. 

 

6. Documents consisting of multiple files 

A document consisting of multiple files must include on the cover 

page of each file, (i) the file number, (ii) the total number of files, 

(iii) the page numbers contained in that file, and (iv) the total 

number of pages for the all the files. The first file must include a 

master chronological and alphabetical index stating the contents 

for all files. The remaining files must include a cover page, but an 

individual index is not required. 
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7. Privacy Protection 

Electronic filers must comply with California Rules of Court, 

rule 1.201 regarding exclusion or redaction of personal 

identifiers from all documents filed with the court. Neither 

TrueFiling nor the Clerk of the Court has any responsibility 

to review documents for compliance with these requirements.  

 

Formatting Guidelines 

 

Filers are encouraged, but not required, to follow these guidelines which 

are designed to improve the functionality and readability of documents 

filed with the court. (See The Leap from E-Filing to E-Briefing, 

Recommendations and Options for Appellate Courts to Improve the 

Functionality and Readability of E-Briefs (2017).) 

 

1. Font Style  

A proportionally spaced serif face, such as Century School 

Book. Do not use Times New Roman.  

 

2. Font size  

13 pt. text (including footnotes). 

 

3. Spacing  

At least 1.5. (Footnotes and quotations may be single spaced.) 

 

4. Margins 

1.5” on all sides. An 8½” by 11” page is very large for a 

publication intended to be read, as distinguished from a reference 

book or the like that is typically not read for an extended period. 

Only the economy and convenience of using standard letter-size 

paper justifies such an oversized page.  Letter-size paper avoids 

the complexities of booklet format, such as laying out signatures, 

trimming pages, saddle stitching the booklet, etc.  See U.S. 

Government Printing Office Style Manual (30th ed. 2008). 
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5. Alignment  

Left Aligned. Left aligned text is easier to read than justified 

text.  Like double spacing, justification is a relic of typesetting 

days, but many legal writers continue to use it out of habit, 

without thinking about the fact that it is less readable. 

 

6. Miscellaneous  

Use “curly” or “smart” quotation marks and apostrophes (rather 

than "straight") Boldface and Italics to be used instead of 

underlining. Do not use ALL CAPS. Emphasis is an effective tool 

when used well.  In terms of readability, most experts prefer 

boldface and italics, and strongly disfavor underlining. 

 

7. File Formatting  

Whenever possible do not scan documents. Convert to 

PDF format in a word processing program. Compile 

documents, e.g. appendices, using E-Copies rather than 

scanned copies with OCR. 

 

8. Hyperlink  

Hyperlinked Briefs. Filers are encouraged to hyperlink their 

briefs and writs to legal citations and appendices or exhibits. 
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COURT OF APPEAL, SECOND APPELLATE DISTRICT  

ELECTRONIC FILING GUIDELINES 

 

 

Guidelines for filing electronic documents in the Court of Appeal that a party 

seeks to become part of the record on appeal. 

 

When filing a motion, application, or request which also includes documents 

the party seeks either: to become part of the court’s record (such as an augmented 

record, amicus curiae brief, supplemental brief, corrected brief, or any other similar 

document); or to be judicially noticed, to ensure that such documents are useable as 

electronic records, this court requests that the party electronically submit 

documents the party seeks to become part of the appellate record as a separate 

.pdf file at the same time as the motion, application or request. 

 

Documents over 300 pages in length. 

Notwithstanding California Rules of Court, rules 8.124(d)(1), 8.144(c)(1) 

and 8.486(c)(1)(A), when submitting documents electronically, the parties may 

exceed the 300-page limit as long as the file size is 25 megabytes or smaller. 

 Proof of Service 

  

 If you create your own proof of service, please include it as the last page of 

your filing rather than a separate pdf. file. 

 

 Civil Case Information Statement 

  

 Please file your Civil Case Information Statement after a docket number has 

been assigned to your appeal. 
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IN THE COURT OF APPEAL OF THE STATE OF CALIFORNIA 
 

SECOND APPELLATE DISTRICT 
 

DIVISION [Division No.] 
 
 
 
 
 

THE THREE BEARS, 
 

Plaintiffs and Respondents,  

v. 

GOLDILOCKS, 
 

Defendant and Appellant. 
 

 
 
 

Court of Appeal No. B___________ 
 
 
Superior Court No. _____________ 

 
 
 
 

[County Name] County Superior Court No. [Case No.]  
Honorable [Judge’s Name] 

 
 
 
 

APPENDIX IN LIEU OF CLERK’S TRANSCRIPT 
(Cal. Rules of Court, rule 8.124) 

 
VOLUME 1 OF 1, PP. 001 to ___ 

 
 
 
 

[Attorney or Party Name] 
State Bar No. [if any] 
[Address] 
[City, State ZIP] 
[Telephone Phone Number] 
[E-mail Address] 

 
Attorney for Appellant 
GOLDILOCKS
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IN THE COURT OF APPEAL OF THE STATE OF CALIFORNIA 
 

SECOND APPELLATE DISTRICT 
 

DIVISION [Division No.] 
 
 
 
 
 

 
THE THREE BEARS, 

Plaintiffs and Respondents,  
 
v. 
 

GOLDILOCKS, 
Defendant and Appellant. 

 

 
 
 

Court of Appeal No. 
B___________ 
 
 
Superior Court No. 
_____________ 

 
 

APPELLANT’S OPENING BRIEF 
 

STATEMENT OF THE CASE 
 

The Three Bears filed a complaint in August 2001 alleging 
Goldilocks had trespassed on their property by entering their home 
when they were not at home, consuming a meal and falling asleep in a 
bed. The complaint alleged that Baby Bear had suffered physical and 
mental damages as a result of being frightened upon discovering 
Goldilocks. (CT 1-4.)  After a civil trial on the matter over a period of 
two days, the court found that Goldilocks had committed trespass.  
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(CT 25.)  The court entered a final judgment in favor of the Three 
Bears in the amount of $50,000.  (CT 27.) 
 
 

STATEMENT OF APPEALABILITY 
 

This appeal is from the judgment of the Los Angeles County 
Superior Court and is authorized by the Code of Civil Procedure, 
section 904.1, subdivision (a)(1). 

 
STATEMENT OF FACTS 

 
Papa Bear lives in Los Angeles, California with his wife, Mama 

Bear and son, Baby Bear. (RT 1.)  Appellant Goldilocks lives a few 
miles away on the other side of the forest. (RT 25.) The Bears' 
neighbor, Gloria Gardner, watched what happened from her garden 
next door.  (RT 15.) 

Gardner testified she saw the Bear family leave their house 
without shutting the front door about 8:00 a.m. and saw Goldilocks 
enter the house at about 8:30. At about 9:30 a.m. she heard 
screams and saw Goldilocks run from the Bears' house.  (RT 17.) 

The Bears testified that when they returned from the walk, 
they saw they had left the front door open. (RT 3.)  Food was 
missing from the dining room table. (RT 4.)  Baby Bear found 
Goldilocks asleep in his bed. (RT 6.)  Terrified, Baby Bear 
screamed and woke up Goldilocks. (RT 9.)  Startled and confused, 
Goldilocks ran from the Bears' house.  (RT 30.) 

An expert bear cub psychologist, Dr. Dramatic, who has done 
extensive research in the phobias of young bears, testified to the 
traumatic effects when a bear cub comes in contact with a human 
child. Baby Bear had physical symptoms of blackouts stemming from 
his encounter with Goldilocks as well as mental anguish requiring 
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therapy. (RT 21-24.) 
Goldilocks testified she was looking for a boarding facility to 

take a rest, the Bears' house was very large, there was no fence to 
indicate this was private property, the door of the house was left open 
and there was a mat at the front door that said "WELCOME".  (RT 
25-26.)  She thought this was a commercial boarding establishment, 
as large amounts of food were set out as if for guests; she looked for 
someone to ask about spending the night and saw several sets of 
chairs and beds all in different sizes. (RT 27-28.)  She sat down on a 
bed and fell asleep. (RT 29.) 
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ARGUMENT 
 
I.  GOLDILOCKS WAS GIVEN IMPLIED 

CONSENT TO ENTER THE HOUSE AND THUS 
HER ENTRY WAS NOT "WRONGFUL" 

 
 

A. The Standard of Review.  
 

The trial court erred in finding that Goldilocks trespassed on the 
Bears' property as there is no substantial evidence to support that 
finding. On review, the appellate court looks to the record to see if 
there are facts to support the trial court or jury's findings. If there is 
any substantial evidence to support the verdict, the court will affirm. 
If there are conflicts in the facts, the court will resolve the conflict in 
favor of the party who won in the trial court. (Williams v. Wraxall 
(1995) 33 Cal.App.4th 120, 132.) 

 
B .  The Elements of the Action.  

 
A trespass occurs when a person intentionally, recklessly or 

negligently enters land in the possession of another. (Gallin v. 
Poulou (1956) 140 Cal.App.2d 638, 645.)  The intent to enter is the 
only intent needed. (Miller v. National Broadcasting Co. (1986) 187 
Cal.App.3d 1463, 1480.)  However, consent or permission to enter 
upon the property is a defense. (Williams v. General Elec. Credit 
Corp. (1946) 159 Cal.App.2d 527, 532; 5 Witkin, Summary of 
California Law (9th ed. 1988) Torts, § 607, p. 706; Rest.2d Torts, § 
167.) 
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C .  No Evidence of Wrongful Entry.  
 

Here, Goldilocks did not intend to enter on private property. 
She thought the Bears' house was a public, commercial boarding 
house.  Although her actual intent is not a legal defense, her actual 
intent reinforces her argument that she had consent to enter the 
building. The door was open, the WELCOME mat was out, the food 
was on the table, and there were many beds and chairs about. All of 
this points to the conclusion the Bears were prepared for and awaiting 
the arrival of numerous persons and supports Goldilocks' belief this 
was a boarding house and there was no reason for her not to enter. At 
a minimum the house was prepared and open for an "open house".  No 
evidence points to any indication the house was closed, off-limits to 
outsiders, or limited in the types of persons who would be admitted. 
There is no evidence to support a finding Goldilocks' entry was 
wrongful.  The judgment must be reversed. 

 
CONCLUSION 

 
Goldilocks submits the Three Bears have failed to meet their 

burden of proving that her entry into their house was wrongful and, 
thus, a trespass. All of the evidence supports a finding that the Bears 
by their conduct consented to Goldilocks' entry. Goldilocks 
respectfully asks that this Court reverse the decision of the trial court 
and vacate the award of damages. 

 
 
Respectfully submitted, 

 
 [Attorney Name] 
 Attorney for Appellant 
 GOLDILOCKS 
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PETITION FOR WRIT OF [TYPE OF WRIT] 
 

 Goldilocks petitions this Court for a writ of mandate or 
other appropriate relief, directing respondent Los Angeles 
County Superior Court to vacate its order denying 
Goldilocks’ motion for summary judgment or alternatively 
summary adjudication and to enter a different order 
granting said motion: 

 … 
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PRAYER 
 

WHEREFORE, Goldilocks prays that a writ of mandate issue 
from this Court commanding the respondent Superior Court to vacate 
its order denying Goldilocks’ motion for summary judgment or, in the 
alternative, for summary adjudication of issues, and to make a new 
and different order granting the motion for summary judgment, and 
for such other relieve as may be just. 

 
 
     _________________________ 
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VERIFICATION 
 

I am the attorney for Goldilocks in this case. I have read the 
foregoing Petition and know its contents. The facts alleged in the 
Petition are within my own knowledge and I know these facts to be 
true.  

I declare under penalty of perjury that the foregoing is true and 
correct and that this verification was executed on this 12th day of 
September, 2017 at Los Angeles, California. 

 
 
     _____________________________ 
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II. 
STATEMENT OF THE CASE 
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CONCLUSION 
 

A writ should issue on the grounds that . . . 
 
 
 

Respectfully submitted, 
 
 Attorney for Petitioner 
 GOLDILOCKS 
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1

LOCAL RULES OF THE COURT OF APPEAL
THIRD APPELLATE DISTRICT

Published pursuant to California Rules of Court, rule 10.1030

Effective September 14, 2015 
Amended effective September 26, 2016 
Amended effective December 11, 2017

Rule 5. Electronic Filing

(a)  Definitions

As used in this local rule, unless the context otherwise requires:

(1)  “Court” means the Court of Appeal for the Third Appellate District.

(2)  “Electronic filing” is the electronic transmission to the court of a document in 
electronic form.

(3)  A “document” is:

(A)  Any filing submitted to the court, including but not limited to a brief, a 
petition, an appendix, or a motion;

(B)  Any document transmitted by a trial court to the court, including but not 
limited to a notice or a clerk’s or reporter’s transcript; or

(C)  Any writing prepared by the court, including but not limited to an opinion, an 
order, or a notice.

(4)  A “file” is a unit of electronic information with a filename.

(5)  “TrueFiling” is the court’s electronic filing portal for registered users.

(6)  “Registered user” and “registered users” refer to a person or persons registered to use 
TrueFiling.

(7) “EFS” means the court’s electronic filing system, which includes, but is not limited 
to, TrueFiling and the court’s file transfer protocol (FTP) server.

(8) “EFS user” and “EFS users” refer to a user or users of the court’s electronic filing 
system.
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2

(b)  Mandatory electronic filing

Pursuant to the California Rules of Court, the court requires the electronic filing of all 
documents with the court unless this local rule provides otherwise. Electronic filing is 
mandatory for all attorneys filing with the court unless an exemption is granted; electronic filing 
is voluntary for all non-attorney self-represented litigants. This local rule applies in all cases, 
including pending cases in which paper documents have been filed before the effective date of 
this local rule. Except as provided in this local rule, an electronic filing will be accepted in lieu 
of any paper copies otherwise required by the California Rules of Court, and constitutes the 
official record of the court.

(c) Registration

(1) Obligation to Register. Each attorney in any proceeding in this court is obligated to 
become a registered user and obtain a username and password for access to TrueFiling unless an 
exemption is granted. Non-attorney self-represented litigants must become registered users if 
they wish to file electronically. Attorneys and non-attorney self-represented litigants may 
become registered users by registering at <http://www.truefiling.com>.

(2) Responsibility; Obligation to Keep Account Information Current. A registered user 
is responsible for all documents filed under the user’s registered username and password. The 
registered user must comply with the requirements of the California Rules of Court.

(d)  File Size Limitation; Documents Exceeding Limitation

(1)  File Size Limitation. The file size limitation is 25 megabytes.

(2)  Documents Exceeding File Size Limitation. Any electronic document larger than 25 
megabytes must be filed in multiple files, each less than 25 megabytes.

(3)  Filing of Document Consisting of More Than Five Files.

(A)  Manual Filing. When a registered user files an electronic document 
consisting of more than five files, the document shall not be filed through TrueFiling, but instead 
shall be filed with the court in electronic format on flash drive, or alternatively on CD (compact 
disc) or DVD.  When a registered user files a flash drive, CD, or DVD with the court, the 
registered user shall also file, on the same day, a “manual filing notification” in TrueFiling
notifying the court and the parties that one or more documents have been filed on flash drive, CD 
or DVD and explaining the reason for the manual filing.

(B) Naming Convention and Format for Files on Flash Drive, CD, or DVD.
Each file on a flash drive, CD, or DVD shall be separately named so the court and the parties can 
see the following identifying information without opening the file:  (1) the case number, (2) the 
type of partial document on the file, (3) the page numbers included in the file, and (4) the last 
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name of the filing party. In addition, each file must comply with the format requirements of this 
local rule.

(C) Manual Service. The flash drive, CD, or DVD shall be served on the parties 
in accordance with the applicable requirements and procedures for service of paper documents.

(e) Format

(1)  Text Searchable Format. All electronic documents must be in electronic text-
searchable PDF (portable document format), or other searchable format approved by the court,
while maintaining original document formatting. If an EFS user possesses only a paper 
document, the user must scan the document and convert it to an electronic document complying 
with this local rule. It is the EFS user’s responsibility to ensure that any document filed is 
complete and readable. Electronically filed documents must comply with the content and form 
requirements of the California Rules of Court, with the exception of those provisions dealing 
exclusively with requirements for paper or as otherwise specified in this local rule.

(2)  Pagination. The page numbering of an electronic document must begin with the first 
page or cover page as page 1 and use only Arabic numerals (e.g., 1, 2, 3) throughout the 
document.  The page number need not appear on the cover page. Briefs may not contain more 
than one numbering system, e.g., they may not contain Roman numerals for the table of contents 
and Arabic numerals for the body of the brief. When a document, transcript, or record is filed in 
both paper format and electronic format, the pagination in both versions must comply with this 
subparagraph or the party must accurately cite to the correct page for both versions.

(3) Documents Consisting of Multiple Files. A document consisting of multiple files 
shall:

(A)  Include on the cover page of each file (i) the file number for that file, (ii)  the 
total number of files for that document, (iii) the page numbers contained in that file, and (iv) the 
total number of pages for that document. (Example: File 1 of 4, pp. 1-299 of 1198.)

(B)  Contain its own table(s) and index stating the contents of that file.

(C) Be paginated consecutively across all files (e.g., if the first file ends on page 
300, the cover of the second file shall be page 301).  

(4) Tabs. Documents shall include tabs to the extent required by the California Rules of 
Court.  A tab shall be a separate page identifying the content following the tab (such as a page 
stating “Exhibit A”).

(5) Electronic Bookmarks.  An electronic bookmark is a text link that appears in the 
bookmarks panel of an electronic document. An electronic bookmark is different from a 
hyperlink. Each document shall include an electronic bookmark to each heading, subheading 
and component of the document (such as a table of contents, table of authorities, petition, 
verification, points and authorities, declaration, certificate of word count, certificate of interested 
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entities or persons, or a proof of service if included within the document). Each document shall 
also include an electronic bookmark to the first page of each tab, exhibit, or attachment, if any.
Each bookmark to a tab, exhibit, or attachment shall include the letter or number of the tab, 
exhibit, or attachment and a description of the tab, exhibit, or attachment.

(6) Hyperlinks. Hyperlinks are not required.  However, if an EFS user elects to include 
hyperlinks in a document, the hyperlink may be active and should be formatted to standard 
citation format as provided in the California Rules of Court.

(7) No Color. Notwithstanding provisions to the contrary in the California Rules of 
Court, electronic documents shall not have color covers, color signatures, or other color 
components absent leave of court. This requirement does not apply to the auto-color feature of 
hyperlinks.

(f) Signatures

For registered users, a registered username and password is the equivalent of an 
electronic signature.

(g) Superior Court Record

(1) Record of Administrative Proceedings. In addition to any administrative record 
provided by the trial court pursuant to the California Rules of Court, registered users seeking 
review of an administrative determination must submit an electronic copy of the administrative 
record to the court in compliance with this local rule.

(2) Appendix. Any appendix filed pursuant to the California Rules of Court must be 
filed by EFS users in electronic format in compliance with this local rule.

(3) Reporter’s Transcript. A registered user who orders a reporter’s transcript of 
proceedings must also request a copy of the transcript in electronic format and must submit an 
electronic copy to the court in compliance with this local rule.

(4) Transmissions by the Superior Court. The court authorizes and encourages the 
superior courts within the Third Appellate District to engage in the electronic service and 
electronic filing of documents, including, but not limited to, the clerk’s transcript and reporter’s 
transcripts. If a superior court transmits electronic documents to the court in lieu of paper, the 
court will accept electronic documents complying with the California Rules of Court and this 
local rule. A superior court shall transmit electronic documents to the court through the court’s 
FTP server using credentials provided by the court.  If a superior court transmits electronic 
documents to the court, it shall also make the electronic documents available to the parties.

(h) Personal Identifiers and Privacy Issues

To protect personal privacy and other legitimate interests, parties and their attorneys must 
not include, or must redact where inclusion is necessary, personal identifiers such as Social 
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Security numbers, driver’s license numbers, and financial account numbers from all documents
filed as part of the court’s public record, whether filed in paper or electronic format, unless 
otherwise provided by law or ordered by the court. If an individual’s Social Security number or 
financial account number is required in a document filed as part of the court’s public record, only 
the last four digits of the number shall be used.

The responsibility for excluding or redacting identifiers from all documents filed with the 
court rests solely with the parties and their attorneys. Neither TrueFiling nor the Clerk of the 
Court has any responsibility to review documents for compliance.

(i) Sealed or Confidential Material

Sealed or confidential material may be filed electronically.  EFS users must comply with 
the California Rules of Court pertaining to sealed and confidential material, with the exception of 
those provisions pertaining exclusively with requirements for paper or as otherwise specified in 
this local rule.

(j) Filing Deadlines

Electronic filing does not alter any filing deadlines. An electronic filing not completely 
received by the court by 11:59 p.m. will be deemed to have been received on the next court day.  
If a specific time of day is set for filing by court order or stipulation, the electronic filing shall be 
completed by that time. Although the EFS permits users to transmit electronic documents 
24 hours a day, EFS users should be aware that telephone or online assistance may not be 
available outside of normal court business hours, and requests for immediate relief made after 
the close of the court’s normal business hours may not be addressed until the next court day.

(k) Motion to Accept Filing as Timely Following TrueFiling Technical Failure

If a registered user fails to meet a filing deadline imposed by court order, rule or law
because of a TrueFiling failure, the registered user may file the document in electronic or paper 
format as soon thereafter as practicable and accompany the filing with a motion to accept the 
document as timely filed. A late submission that missed a jurisdictional deadline will be 
accepted for filing pursuant to this subparagraph only if the deadline was missed due to a
TrueFiling failure. The initial point of contact for anyone experiencing difficulty with 
TrueFiling shall be the toll-free telephone number posted on the TrueFiling Web site.

The court is not responsible for malfunctions or errors occurring in the electronic 
transmission or receipt of electronically filed documents.

(l) Service

Registration with TrueFiling constitutes consent to receive service through the EFS.
Documents prepared by the court will be served on EFS users through the EFS or by electronic 
notification.
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Submission of a petition for review through TrueFiling that is accepted for filing by the 
Supreme Court constitutes service of a copy of the petition on this court in accordance with the
California Rules of Court. 

(m) Filing Fees

TrueFiling is operated by a vendor pursuant to a contract with the court. The vendor will 
assess fees for each electronic filing via TrueFiling in accordance with the schedule posted on 
the TrueFiling Web site, as approved by the court. TrueFiling fees will be considered 
recoverable costs under the California Rules of Court. The vendor is designated as the court’s 
agent for collection of court-imposed fees where required for any electronic filing made by 
registered users, and any associated credit card or bank charges or convenience fees.

If a non-attorney self-represented litigant with a fee waiver chooses to file documents 
electronically, that litigant is exempt from the fees and costs associated with electronic filing.
The persons and entities identified in Government Code section 6103 are also exempt from the
fees and costs associated with the EFS.

(n) Exemptions

(1)  Non-attorney self-represented litigants may, but are not required to, register for 
electronic filing. Non-attorney self-represented litigants who opt to register for electronic filing
must comply with this local rule and the requirements of the EFS.

(2)  When it is not feasible for a registered user to convert a document to electronic 
format by scanning, imaging or other means, the document may be filed in paper format with a 
declaration setting forth the reason that electronic filing was not feasible.

(3)  If the requirements of this local rule cause undue hardship or significant prejudice to 
any registered user, the registered user may file a motion for an exemption from the requirements 
of this local rule.

(o)  Rejection of an Electronic Filing for Noncompliance

The court will reject an electronic filing if it does not comply with the requirements of 
this local rule.

(p) Sanctions for Noncompliance

Failure of counsel to timely register, and failure of any registered user to comply with 
electronic filing requirements, unless exempted, may be subject to sanctions imposed by the 
court.
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(q)  Original Documents

The court may scan any paper document into an electronic format, in which case the 
electronic document will be deemed the original for purposes of the court record. 

(r) Posting and Publication

The Clerk of the Court is directed to post a copy of this local rule on the court’s Web site 
and submit a copy to the Reporter of Decisions for publication. 

Dated: 

__________________
Presiding Justice

September 27, 2017

_______________
P idi J i
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Consecutive Pagination Across Multiple PDF Files 
 
Pursuant to Local Rule 5 (3)(c), documents consisting of multiple files must be paginated consecutively.  For 
example, if the first file of multiple volumes ends on page 234, the second file must begin on page 235.   
 
Pagination must also be reflected accurately in Adobe Acrobat’s page counter, even across multiple files.   
 

 
 
To achieve this, start by opening up the second PDF file of your document in Adobe Acrobat.  Next, click View 
on the menu bar, hover your cursor over Tools, and then select Document Processing.  A column should 
appear on the right side of your screen.   
 

 
 

 
Select Number Pages from the column to open a small popup window titled Page Numbering.   
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Under the Pages section, select All.  Under the Numbering section, change the Start parameter to match the 
first page of the file.  For example, if the first page of the file is 235, change the Start parameter to 235.  Then 
click OK.  

 

 
 

Save the file, and then repeat this process for any additional files in your document. 
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LOCAL RULES OF THE COURT OF APPEAL 
FOURTH APPELLATE DISTRICT  

 
 
 
Rule 1. Writ Proceedings 

 
(a) [Request for immediate stay] A request that an immediate stay be 

issued or other immediate relief be granted is to be served on the respondent and 
each real party in interest by (1) personal delivery or (2) an expeditious method 
consented to in advance by the party served.  If the respondent or any real party in 
interest is not served personally or by an expeditious method consented to in 
advance by the party served, the court will not act on the request for five days, 
except to deny it summarily, absent a showing of good cause. The document 
cover must state conspicuously "STAY REQUESTED" or "IMMEDIATE 
RELIEF REQUESTED" or words of similar effect. 

 
The court may issue a stay or other order necessary to preserve the status 

quo or the court's jurisdiction without opposition. However, a request for 
immediate relief, other than a stay or other order necessary to preserve the status 
quo or the court's jurisdiction, will not be granted unless the court has received an 
unsolicited opposition or, alternatively, has requested opposition. 

 
(b) [Preliminary opposition] In an extraordinary proceeding involving a 

petition for writ of mandate, certiorari or prohibition pursuant to California Rules 
of Court, rules 8.485-8.493, the real party in interest need not file a preliminary 
opposition as provided in rule 8.487(a) unless requested to do so by the court. 
Except as provided in subdivision (a) of this rule, the court will not take any action 
on a writ petition, other than to summarily deny it, without first giving the real 
party in interest an opportunity to respond. 

 

 
(Amended, eff. Aug. 13, 2010; adopted, eff. Oct. 29, 2004.) 

 
Rule 2. Covers on Documents Filed With The Court 

 
The court will not accept for filing any document that has a plastic or 

acetate cover or does not conform strictly to rules 8.144 and 8.204 of the 
California Rules of Court. 

 
(Adopted, eff. Oct. 2, 1983.  As amended, eff. Oct. 29, 2004; Jan. 1, 2007.) 
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Rule 3. Stipulation for Use of Original Superior Court File 
 

Rule 8.128 of the California Rules of Court provides for the use of the 
original superior court file in lieu of the clerk's transcript on appeal in those civil 
cases where the parties so stipulate. In accordance with rule 8.128 of the 
California Rules of Court, the procedure therein is approved for use by the 
superior courts within this district unless the Court of Appeal orders otherwise in a 
particular case. 

 
(Formerly Rule 10, adopted, eff. April 26, 1992.  Renumbered Rule 3, eff. Oct. 29, 
2004. As amended, eff. Jan. 1, 2007.) 

 
Rule 4. Civil Settlement Conference Procedures (Division Two Only) 

 
(a) [Application of rule] This rule is adopted pursuant to rule 8.248, 

California Rules of Court, and shall apply to all civil cases except appeals from 
proceedings under sections 300, 601, and 602 of the Welfare and Institutions 
Code, appeals from proceedings under sections 221 and 232 of the Civil Code, and 
appeals from original proceedings ancillary to a criminal prosecution. 

 
(b) [Notice of availability of conference] Upon receipt of notice of the 

filing of a notice of appeal, the clerk of this court shall mail a copy of this rule to 
counsel for all parties. 

 
(c) [General settlement conference procedure] 

 
(1) The presiding justice may schedule a settlement conference and 

order the parties' attendance at any time during the pendency of an appeal. 
 

(2) Written notice of the date and time of the settlement conference 
will be given by the court. 

 
(3) Immediately upon accepting a case for the settlement conference 

procedure, all further proceedings, including the filing of briefs, shall be 
suspended until further order of the court. However, this rule shall not 
suspend preparation of the appellate record unless a specific order is issued 
directing suspension of record preparation. 

 
(d) [Prebriefing settlement conference procedure and sanctions] 

 
(1) A request for a settlement conference to be held prior to 

completion of briefing shall be served and filed within 30 days from the 
date of mailing of the notice specified in subdivision (b). Opposition to a 
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request for a settlement conference must be served and filed within 15 days 
after the request's filing date. 

 
(2) If the court orders a settlement conference prior to the 

completion of briefing, the parties shall each serve and file an original and 
one copy of a settlement conference statement at least 15 days before the 
settlement conference. The parties may file by the same date a joint 
settlement conference statement in lieu of separate statements. Failure to 
timely serve and file a settlement conference statement complying with this 
rule may result in the imposition of sanctions including dismissal of the 
appeal. Every settlement conference statement shall contain the following: 

 
(A) The trial court name and case title and number; 

 
(B) The name of the judge who rendered the judgment or 

order appealed and the date of its entry; 
 

(C) The date the notice of appeal was filed; 
 

(D) The names, address, and telephone numbers of counsel 
for all parties to the appeal; 

(E) A brief description of the judgment or order appealed; 

(F) A concise statement of the case, including a brief 
procedural history and all facts material to consideration of the 
issues presented; and, 

 
(G) The issues expected to be raised in the briefs. 

 
(e) [Postbriefing settlement conference procedure and sanctions] After 

briefing is completed, the court may request the parties to provide information 
helpful to the court in deciding whether to order the parties to participate in a 
settlement conference. The parties shall complete all post-briefing settlement 
conference questionnaires and respond to all confidential settlement conference 
inquiries within 15 days of mailing by the clerk of the court. Failure to timely 
respond to a settlement conference inquiry or questionnaire may result in the 
imposition of sanctions including dismissal of the appeal. 

 
(f) [Settlement conference and sanctions] 

 
(1) The court shall maintain a list of attorneys who have developed 

expertise in specified areas of law, are generally respected in the legal 
community, and are willing to mediate settlement conferences at this court. 
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These attorneys shall be designated as settlement conference mediators and 
preside over every settlement conference unless otherwise ordered. A 
justice or assigned justice may be designated as a settlement conference 
mediator and preside over a settlement conference if so ordered. 

 
(2) The mediator presiding over a settlement conference may in his 

or her discretion continue it from time to time to allow for further 
negotiation. 

 
(3) Counsel for every party to the appeal and their clients shall 

attend any settlement conference. Failure to attend a settlement conference 
may result in the imposition of sanctions against any party or counsel, 
including dismissal. 

 
(4) The settlement conference mediator may invite parties to the 

action who are not parties to the appeal, or any person who has an interest 
in the action, to attend the settlement conference if it appears to the 
mediator that their presence may facilitate settlement of the case. Any party 
to the appeal may serve and file a written request for the attendance of such 
a party or person at least 15 days before the settlement conference. 

 
(5) Counsel shall confer with their clients in advance and be 

thoroughly familiar with the case and prepared to present their contentions 
in detail. 

 
(6) The presiding justice, a justice designated by the presiding 

justice, or the settlement conference mediator may excuse a client's 
personal attendance upon request and a showing that hardship or unusual 
circumstances make the client's attendance impossible or impractical. If 
personal attendance is excused, counsel either shall have obtained full 
authority to agree to a settlement that binds the client or the client shall be 
available for consultation by telephone. 

 
(7) Where settlement cannot be reached, partial settlement will be 

sought. Any settlement shall be reduced to writing and signed by counsel. 
After a complete settlement has been agreed to in writing, the parties shall 
promptly file a stipulation to dismiss the appeal on the ground that the case 
has been settled. The stipulation shall specify the allocation of costs on 
appeal and state whether the remittitur is to issue immediately. 
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(g) [Disqualification of settlement conference justice] 
 

(1) A justice or assigned justice who participates in a settlement 
conference that does not result in complete settlement shall not thereafter 
participate in any way in the consideration or disposition of the case on its 
merits. 

 
(2) A justice or assigned justice of the court will not be disqualified to 

participate in the consideration or disposition of a case on its merits because he 
or she has ruled on a request for a settlement conference, ordered that a 
settlement conference be held, signed orders granting relief from default for an 
act required by a party under this rule, extended or shortened any time period 
specified in this rule, or otherwise signed an order concerning a procedural 
aspect of the settlement conference process. Only mediating a settlement 
conference shall disqualify a justice from consideration or disposition of the case 
on its merits. 

 
(Adopted, eff. Oct.13, 1992.  As amended, eff. Oct. 29, 2004; Jan. 1, 2007.) 

 
Rule 5.  Reporter's Transcripts in Felony Appeals 
 

 (a) Except as provided in (b), defendant’s counsel is deemed to have requested under 
Code of Civil Procedure section 271(a)(1) that his or her copy of the reporter’s 
transcript be delivered in paper form. 

 
 (b) Within 15 days after the notice of appeal is filed, defendant’s counsel, or, if the 

defendant is not yet represented by appellate counsel, the district appellate project, 
may serve the lead court reporter and the superior court with a request that defendant’s 
counsel’s copy of the reporter’s transcript be delivered in electronic form.  

 
(Adopted, eff. February 23, 2018.  Previously repealed eff. January 1, 2017.) 
 
 
 
Rule 6.  Repealed, eff. Sept. 9, 1996  
Rule 7.  Repealed, eff. Dec. 1, 2003 
Rule 8.  Repealed, eff. Oct. 29, 2004 
Rule 9. Repealed, eff. March 10, 2003 
Rule 10. Renumbered Rule 3, eff. Oct. 29, 2004 
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COURT OF APPEAL, FOURTH APPELLATE 

DISTRICT UPDATED ELECTRONIC FILING 

GUIDELINES 
 
 
 
Guidelines for submitting documents to the Court of Appeal that a party seeks to 

become part of the record on appeal. 
 
 
It has come to the court's attention that parties occasionally file a motion, application, or 

request which also includes documents the party seeks either: to become part of the 

court’s record (such as an augmented record, supplemental brief, corrected brief, or any 

other similar document); or to be judicially noticed.  When a party electronically 

incorporates the documents they wish to be part of the record on appeal into the motion, 

application or request, the court has no way of separating the documents to become part 

of the official record or to be judicially noticed. Therefore, the court has established the 

following guidelines for submitting such documents in electronic form. 

To ensure that such documents are useable as electronic records, this court 

requests that the party: 

1.  Electronically submit documents the party seeks to become part of the 

appellate record as a separate .pdf file at the same time as the motion, application or 

request. 
 

2.  Ensure such documents are formatted in compliance with California Rules of 
Court, rule 8.74(b) 

 
 
 

Guidelines for submitting documents over 300 pages in length. 
 

Notwithstanding California Rules of Court, rules 8.124(d)(1), 8.144(c)(1) and 
 
8.486(c)(1)(A), when submitting documents electronically, the parties may exceed the 

 
300-page limit as long as the file size is 25 megabytes or smaller. 
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Adobe PDF Bookmark Zoom Settings 

PROBLEM: 

When a PDF is submitted with bookmarks, the bookmarks can contain custom/specific document zoom 

settings that change the zoom percentage of the document whenever a bookmark is clicked.  When a 

user changes the zoom back to their preferred value, upon clicking the same bookmark or any other 

bookmark, the view changes to the zoom setting specified in the properties of each individual 

bookmark. 

Example of problem from “viewer’s” perspective: 

1. Open PDF document (the document opens with default zoom settings that the viewer has set in

Adobe Reader or Adobe Acrobat Pro).  In this case, the viewer has 150% set as their default

zoom setting for all documents when opened.

2. Upon clicking on a bookmark, the document zoom setting changes to the specific zoom setting

embedded in the properties of the individual bookmark.  In this example, the bookmark has a

zoom setting of “Fit Page” which equates to 85.4% on the monitor/resolution used to create this

help document.  You will see this setting later in the document, but the image below shows how

the percentage changes from 150% to 85.4% when clicking on the bookmark.
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3. If the viewer elects to then zoom back out/in depending on their preference, upon clicking the

same bookmark or another bookmark, the zoom once again changes to what is set in the

properties of the bookmark.  In other words, the problem continues to repeat itself throughout

the document when clicking on various bookmarks.

CAUSE: 

Adobe bookmarks (each individual bookmark) have a zoom setting in “Properties”.  Some creators of 

Adobe PDF documents (either intentional or non-intentional) or by Adobe Acrobat’s default set a 

specific zoom setting for each bookmark (e.g. “Fit Page”).   

One can see this setting (using Adobe Acrobat) by “right-clicking” on a single bookmark and selecting 

“Properties”. 
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Click on the “Actions” tab and you can then see the customized/specific zoom level for that specific 

bookmark. 
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Clicking the “Edit” button allows the PDF document creator to select a different zoom level. 
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The required setting for all PDF documents filed with or transmitted to the Courts of Appeal and the 

Supreme Court is “Inherit Zoom” which allows for each bookmark to use the same zoom setting set by 

the viewer. 

Viewers of documents prefer to have a PDF document display based on their own zoom/view setting 

that they can select just once in Adobe Reader or Adobe Acrobat, which applies to any document the 

viewer opens. 

RESOLUTION: 

When creating a PDF document, once all bookmarks have been created, perform the following steps to 

change the zoom setting for each bookmark: 

1. In Adobe Acrobat, “right-click” the first bookmark and select “Properties” as shown above

2. Click on the “Actions” tab

3. Click the “Edit” button

4. Change the “Zoom” setting to “Inherit Zoom”

5. Click OK

6. Repeat for ALL additional bookmarks

NOTE:  The other option is that this option be selected during the creation of each individual bookmark 

rather than going back and editing each bookmark.  It’s a matter of preference for the PDF creator. 

OTHER: 

https://forums.adobe.com/thread/1339241?start=0&tstart=0 
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Adobe PDF Bookmark Zoom Settings 

PROBLEM: 

When a PDF is submitted with bookmarks, the bookmarks can contain custom/specific document zoom 

settings that change the zoom percentage of the document whenever a bookmark is clicked.  When a 

user changes the zoom back to their preferred value, upon clicking the same bookmark or any other 

bookmark, the view changes to the zoom setting specified in the properties of each individual 

bookmark. 

Example of problem from “viewer’s” perspective: 

1. Open PDF document (the document opens with default zoom settings that the viewer has set in

Adobe Reader or Adobe Acrobat Pro).  In this case, the viewer has 150% set as their default

zoom setting for all documents when opened.

2. Upon clicking on a bookmark, the document zoom setting changes to the specific zoom setting

embedded in the properties of the individual bookmark.  In this example, the bookmark has a

zoom setting of “Fit Page” which equates to 85.4% on the monitor/resolution used to create this

help document.  You will see this setting later in the document, but the image below shows how

the percentage changes from 150% to 85.4% when clicking on the bookmark.
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3. If the viewer elects to then zoom back out/in depending on their preference, upon clicking the

same bookmark or another bookmark, the zoom once again changes to what is set in the

properties of the bookmark.  In other words, the problem continues to repeat itself throughout

the document when clicking on various bookmarks.

CAUSE: 

Adobe bookmarks (each individual bookmark) have a zoom setting in “Properties”.  Some creators of 

Adobe PDF documents (either intentional or non-intentional) or by Adobe Acrobat’s default set a 

specific zoom setting for each bookmark (e.g. “Fit Page”).   

One can see this setting (using Adobe Acrobat) by “right-clicking” on a single bookmark and selecting 

“Properties”. 
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Click on the “Actions” tab and you can then see the customized/specific zoom level for that specific 

bookmark. 
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Clicking the “Edit” button allows the PDF document creator to select a different zoom level. 
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The required setting for all PDF documents filed with or transmitted to the Courts of Appeal and the 

Supreme Court is “Inherit Zoom” which allows for each bookmark to use the same zoom setting set by 

the viewer. 

Viewers of documents prefer to have a PDF document display based on their own zoom/view setting 

that they can select just once in Adobe Reader or Adobe Acrobat, which applies to any document the 

viewer opens. 

RESOLUTION: 

When creating a PDF document, once all bookmarks have been created, perform the following steps to 

change the zoom setting for each bookmark: 

1. In Adobe Acrobat, “right-click” the first bookmark and select “Properties” as shown above

2. Click on the “Actions” tab

3. Click the “Edit” button

4. Change the “Zoom” setting to “Inherit Zoom”

5. Click OK

6. Repeat for ALL additional bookmarks

NOTE:  The other option is that this option be selected during the creation of each individual bookmark 

rather than going back and editing each bookmark.  It’s a matter of preference for the PDF creator. 

OTHER: 

https://forums.adobe.com/thread/1339241?start=0&tstart=0 
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Formatting Guidelines 
 
The Court encourages all electronic filers to comply with the following 

guidelines for briefs, motions, appendices, writ petitions and other documents 
filed in connection with appeals or original proceedings.  

 
Pagination:  
            Number pages consecutively beginning with the cover page of the 

document, using only the Arabic numbering system, as in 1, 2, 3.  Do 
not use a separate pagination system for tables within the document.  
The page number does not need to appear on the cover page. 

 
Bookmarks: 
             

Briefs, motions and petitions:  In any document that contains a table 
of contents, the table should include an electronic bookmark for each 
heading to the corresponding heading in the text. 
A bookmark is a text link that appears in the Bookmarks Panel of 
Adobe Reader and Adobe Acrobat.  In this example, clicking on 
“INTRODUCTION” would take the reader to that part of the brief. 
 

 
 
Appendices and exhibits:   In any document that contains an index, 
including appendices and exhibits in support of writ petitions, the 
index should include an electronic bookmark from each descriptive 
document title to the first page of the corresponding document in 
the appendix or exhibits. 
 
Where appendices or exhibits are submitted in multi-part electronic 
files, each separate file should have a table or index stating the 
contents of that file.  The table or index should include the 
bookmarks as noted above.  
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Formatting Guidelines for an Appendix 
 
 

To ensure that your appendix is not rejected by the court, please comply with the 
following guidelines. 
 

Pagination: 
Number pages consecutively beginning with the cover (first) page of the 
appendix  to the final page of the appendix, using only the Arabic numbering 
system, as in 1, 2, 3.  Do not use Roman Numerals or any other pagination 
method  for tables or anywhere else within the appendix. 

 
Ensure that page numbers listed in the Table of Contents or Indices match 
both the pages within the appendix and the Adobe page counter.  This 
allows the court and the parties to accurately locate the cited pages and 
ensures that page citations are consistent throughout the appendix. 

 
Notwithstanding California Rules of Court, rules 8.124(d)(1), 8.144(c)(1) and 
8.486(c)(1)(A), electronically filed documents may exceed the 300‐page limit 
as long as the file size is 25 megabytes or smaller. An appendix that exceeds 
25 megabytes must be submitted in multiple volumes of 25 megabytes or 
less.  Each volume must be numbered consecutively from the first (cover) 
page of the first volume to the last page of the last volume, using only the 
Arabic numbering system, as in 1, 2, 3.  Each volume should contain a cover 
page, indicating the volume number and alphabetical and chronological 
indexes pursuant to the electronic filing requirements of the Fourth District 
(CRC, Rule 8.72(a) and 8.74(b)).  Also, the indexes themselves should be 
included as part of the sequential pagination.  Slip sheets are not necessary 
because of bookmarks.  If slip sheets are used, they must be included as 
part of the sequential pagination. 
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Bookmarks: 
The Table of Contents or Index must include an electronic bookmark for 
each heading corresponding to the heading in the text, including the 
heading “Table of Contents” or “Index.” 

 

 

 

A bookmark is a text link that appears in the Bookmarks Panel of Adobe
Reader  and  Adobe  Acrobat.  In  this  example,  clicking  on  the  “Minute
Order” would take the reader to that part of the document. 
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Formatting Guidelines for Briefs 

To ensure that your brief is not rejected by the court, please comply with the 
following guidelines. 

Pagination: 
Number pages consecutively beginning with cover page of the brief to the 
final page, using only the Arabic numbering system, as in 1, 2, 3.  Do not use 
Roman Numerals or any other pagination method for tables or anywhere 
else within the brief.   

Ensure that page numbers listed in the Table of Contents match both the 
pages within the document and the Adobe page counter.  This allows the 
court and the parties to accurately locate the cited pages and ensures that 
page citations are consistent throughout the brief. 

Bookmarks: 
The Table of Contents must include an electronic bookmark for each 
heading corresponding to the heading in the text, including the heading 
“Table of Contents.”  Briefs that contain exhibits should list the exhibits in 
the Table of Contents identifying the exhibits as well as include electronic 
bookmarks for each of the exhibits.  
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A bookmark is a text link that appears in the Bookmarks Panel of Adobe 
Reader and Adobe Acrobat.  In this example, clicking on the “Argument” 
would take the reader to that part of the document. 
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Formatting Guidelines for Exhibits to Petition 
 
 

To ensure that your exhibits to your petition are not rejected by the court, please 
comply with the following guidelines. 
 

Pagination: 
Number pages consecutively beginning with the cover (first) page of the 
exhibits  to the final page of the exhibits, using only the Arabic numbering 
system, as  in 1, 2, 3.  Do not use Roman Numerals or any other pagination 
method for  tables or anywhere else within the exhibits. 

 
Ensure that page numbers listed in the Table of Contents or Indices match 
both the pages within the exhibits and the Adobe page counter.  This 
allows the court and the parties to accurately locate the cited pages and 
ensures that page citations are consistent throughout the exhibits. 

 
Notwithstanding California Rules of Court, rules 8.144(c)(1) and 
8.486(c)(1)(A), electronically filed documents may  exceed the 300‐page 
limit as long as the file size is 25 megabytes or smaller.  Exhibits that exceed 
25 megabytes must be submitted in volumes of 25 megabytes or less.  Each 
volume must be numbered consecutively from  the first page of the first 
volume to the last page of the last volume, using only the Arabic numbering 
system, as in 1, 2, 3.  Each volume must contain a cover page indicating the 
volume number and a table of contents. 
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Bookmarks: 
The Table of Contents or Index must include an electronic bookmark for 
each heading corresponding to the heading in the text, including the 
heading “Table of Contents” or “Index.” 

 

A bookmark is a text link that appears in the Bookmarks Panel of Adobe 
Reader and Adobe Acrobat.  In this example, clicking on “Exhibit 1” would 
take the reader to that part of the document. 
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Formatting Guidelines for Exhibits to Petition 
 
 

To ensure that your exhibits to your petition are not rejected by the court, please 
comply with the following guidelines. 
 

Pagination: 
Number pages consecutively beginning with the cover (first) page of the 
exhibits  to the final page of the exhibits, using only the Arabic numbering 
system, as  in 1, 2, 3.  Do not use Roman Numerals or any other pagination 
method for  tables or anywhere else within the exhibits. 

 
Ensure that page numbers listed in the Table of Contents or Indices match 
both the pages within the exhibits and the Adobe page counter.  This 
allows the court and the parties to accurately locate the cited pages and 
ensures that page citations are consistent throughout the exhibits. 

 
Notwithstanding California Rules of Court, rules 8.144(c)(1) and 
8.486(c)(1)(A), electronically filed documents may  exceed the 300‐page 
limit as long as the file size is 25 megabytes or smaller.  Exhibits that exceed 
25 megabytes must be submitted in volumes of 25 megabytes or less.  Each 
volume must be numbered consecutively from  the first page of the first 
volume to the last page of the last volume, using only the Arabic numbering 
system, as in 1, 2, 3.  Each volume must contain a cover page indicating the 
volume number and a table of contents. 
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Bookmarks: 
The Table of Contents or Index must include an electronic bookmark for 
each heading corresponding to the heading in the text, including the 
heading “Table of Contents” or “Index.” 

 

A bookmark is a text link that appears in the Bookmarks Panel of Adobe 
Reader and Adobe Acrobat.  In this example, clicking on “Exhibit 1” would 
take the reader to that part of the document. 
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Formatting Guidelines for Petitions 

To ensure that your petition is not rejected by the court, please comply with the 
following guidelines. 

Pagination: 
Number pages consecutively beginning with cover page of the petition to 
the final page, using only the Arabic numbering system, as in 1, 2, 3.  Do not 
use Roman Numerals or any other pagination method for tables or 
anywhere else within the petition.   

Ensure that page numbers listed in the Table of Contents match both the 
pages within the document and the Adobe page counter.  This allows the 
court and the parties to accurately locate the cited pages and ensures that 
page citations are consistent throughout the petition 

Bookmarks: 
The Table of Contents must include an electronic bookmark for each 
heading corresponding to the heading in the text, including the heading 
“Table of Contents.”  Petitions that contain exhibits under the same cover 
should list the exhibits in the Table of Contents identifying the exhibits as 
well as include electronic bookmarks for each of the exhibits.  

A bookmark is a text link that appears in the Bookmarks Panel of Adobe 
Reader and Adobe Acrobat.  In this example, clicking on the “Table of 
Contents” would take the reader to that part of the document. 
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Electronic Formatting Requirements of the Fourth District Pursuant to California 

Rules of Court, Rule 8.72(a) and 8.74(b) 

effective June 1, 2018 

1. All documents must be text-searchable, in PDF (portable document format) while 

maintaining the original document formatting. 

 

2. The page numbering of a document filed electronically must begin with the first page or 

cover as page 1 and use only Arabic numerals (e.g., 1, 2, 3).   

 

3. In appeals, a brief and an appendix filed pursuant to California Rules of Court, rule 8.124 

must contain electronic bookmarks.  A brief must include electronic bookmarks to each 

heading, subheading and component of the brief (such as the table of contents, table of 

authorities, certificate of word count, certificate of interested entities or persons, and 

proof of service if included with the brief), and to the first page of each exhibit or 

attachment.  Each bookmark to an exhibit or attachment must include the letter or number 

of the exhibit or attachment and a description of the exhibit or attachment.  An appendix 

must include electronic bookmarks to each component of the appendix and to each 

document contained in the appendix; each bookmark to a document must include the 

name and date of the document. 

 

4. A document consisting of multiple files must include on the cover pages of each file, (i) 

the file number, (ii) the total number of files, (iii) the page numbers contained in that file, 

and (iv) the total number of pages for all the files.  The first file must include a master 

chronological and alphabetical index stating the contents for all files.  The remaining files 

must include a cover page, but an individual index is not required.   

 

5. In original proceedings, a petition or response must include electronic bookmarks to each 

heading, subheading and component (such as the table of contents, table of authorities, 

petition, verification, points and authorities, declaration, certificate of word count, and 

proof of service if included within the petition), and to the first page of each exhibit or 

attachment, if any; each bookmark to an exhibit or attachment must include the letter or 

number of the exhibit or attachment and a description of the exhibit or attachment.   

 

6. In motions, a motion must include electronic bookmarks to each component (such as 

points and authorities, declarations, and proof of service), and to the first page of any 

exhibits or attachment.  Each bookmark to an exhibit or attachment must include the 

letter or number of the exhibit or attachment and a description of the exhibit or 

attachment 

 

7. No single PDF file may exceed a total of 25 megabytes.  If a filing exceeds this file size 

limitation the TrueFiling user must either (a) submit the filing in multiple parts or (b) 

provide the court with the filing in electronic format on a CD (compact disc), DVD or 

JATS MATERIALS E-BINDER PAGE 160



flash drive.  Please note any audio files must be submitted in .wav or mp3 format and any 

video files must be submitted in .avi or mp4 format. 
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5DCA-Rule 8 Electronic Filing 
 
Rule 8. Electronic Filing 
Local	Rule	8.	Electronic	Filing	 
Pursuant to California Rules of Court, rule 8.70, the Court will require all filings in this District be 
made through the Court’s electronic filing system (EFS) operated by ImageSoft TrueFiling 
(TrueFiling). Use of the EFS system is mandatory for all attorneys filing in this District, unless an 
exemption is granted, and is voluntary for all self-represented litigants. A filing in electronic format 
will be accepted in lieu of any paper copies otherwise required under California Rules of Court, rule 
8.44and constitutes the official record of the Court. 

(a)	[Registration] 

(1) Obligation to Register. Each attorney of record in any proceeding in this District is obligated to 
become an EFS user and obtain a user ID and password for access to the TrueFiling system. Self-
represented litigants must register if they wish to e-file. Attorneys and self-represented litigants 
may register at: https://www.truefiling.com/_layouts/ElectronicFile.Main/SignUp.aspx 

(2) Obligation to Keep Account Information Current. An EFS user is responsible for all documents 
filed under the user’s registered ID and password. Registered users are required to keep their e-
mail address current and may update their e-mail address online via the TrueFiling Web site. The 
user also must comply with the requirements of California Rules of Court, rule 8.32. 
(b)	[Format]  
Documents filed electronically must be in PDF format, or readily capable of conversion to PDF 
format while maintaining original document formatting by TrueFiling to permit text searches and 
to facilitate transmission and retrieval. If the filer possesses only a paper copy of a document, it may 
be scanned to convert it to a searchable PDF format. It is the filer’s responsibility to ensure that any 
document filed is complete and readable. No single document shall exceed a total file size of 25 MB. 
Document pages must be consecutively numbered beginning from the cover page of the document 
and using only the Arabic numbering system, as in 1, 2, 3. 

Briefs must comply with the content and form requirements of California Rules of Court, rule 8.204, 
with the exception of those provisions dealing exclusively with requirements for paper. 
Notwithstanding rule 8.204(b)(7), briefs may not have different numbering systems. The table of 
contents for each brief shall include electronic bookmarks to each heading in the text. All original 
proceedings must include electronic bookmarks from the table of contents for each heading in the 
text, and to the first page of any exhibit(s), with a description of the exhibit included in the 
bookmark. 

(c)	[Signatures]  
A TrueFiling user ID and password is the equivalent of an electronic signature for a registered 
attorney or party. Any document displaying the symbol “/s/” with the attorney’s or party’s printed 
name shall be deemed signed by that attorney/party. 

(d)	[Trial	Court	Record] 

(1) Appendices, Agreed Statements, and Settled Statements. Parties must submit any appendix filed 
pursuant to California Rules of Court, rule 8.124, any agreed statement filed pursuant to California 
Rules of Court, rule 8.134, or any settled statement filed pursuant to California Rules of 
Court, rule 8.137 in electronic form. Each part of the record submitted in any appendix shall clearly 
state the volume and page numbers included within that part and include an index of contents, with 
a descriptive electronic bookmark to the first page of each indexed document. 
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(2) Administrative Records. In addition to any administrative record provided by the trial court 
pursuant to California Rules of Court, rule 8.123, the party or parties seeking review of a board case 
under California Rules of Court, rule 8.498(b) must submit a copy of the administrative record in 
electronic form. 

(3) Reporter’s Transcripts. Any party who orders a reporter’s transcript of proceedings pursuant to 
California Rules of Court, rule 8.130 must also request a copy of the transcript in computer-
readable format, as provided in California Rules of Court, rule 8.130(f)(4), and submit an electronic 
copy to the Court. 
(e)	[Personal	Identifiers	and	Privacy	Issues]  
To protect personal privacy, parties and their attorneys must not include, or must redact where 
inclusion is necessary, personal identifiers such as social security numbers, driver’s license 
numbers, and financial account numbers from all pleadings and other papers filed in the Court’s 
public file, whether filed in paper or electronic form, unless otherwise provided by law or ordered 
by the Court. (California Rules of Court, rule 1.20(b).) If an individual’s social security number is 
required in a pleading or other paper filed in the public file, only the last four digits of that number 
shall be used. If financial account numbers are required in a pleading or other paper filed in the 
public file, only the last four digits of these numbers shall be used. 

The responsibility for excluding or redacting identifiers from all documents filed with the Court 
rests solely with the parties and their attorneys. (California Rules of Court, rule 1.20(b)(3).) Neither 
TrueFiling nor the Clerk of the Court has any responsibility to review pleadings or other papers for 
compliance. 

(f)	[Sealed	or	Confidential	Material] 
All filers must comply with California Rules of Court, rules 8.46 and 8.47 pertaining to sealed and 
confidential material. 

(g)	[Filing	Deadlines]  
Filing documents electronically does not alter any filing deadlines. In order to be timely filed on the 
day they are due, all electronic transmissions of documents must be completed (i.e., received 
completely by the Clerk of the Court) prior to midnight. Where a specific time of day is set for filing 
by Court order or stipulation, the electronic filing shall be completed by that time. Although EFS 
permits parties to submit documents electronically 24 hours a day, users should be aware that 
telephone or online EFS assistance may not be available outside of normal Court business hours. 

(h)	[Technical	Failure/Motions	for	Late	Filing]  
If a filer fails to meet a filing deadline imposed by Court order, rule, or statute because of a failure at 
any point in the electronic transmission and receipt of a document, the filer may file the document 
as soon thereafter as practicable and accompany the filing with a motion to accept the document as 
timely filed. (See Cal. Rules of Court, rule 8.54(a)(1)&(2).) 

The Clerk of the Court shall deem the EFS system to be subject to a technical failure whenever the 
system is unable to accept filings continuously or intermittently over the course of any period of 
time greater than one hour after 12:00 noon that day. Filings due on the day of a technical failure 
which were not filed solely due to such technical failure shall be due the next court day. The initial 
point of contact for any practitioner experiencing difficulty filing a document into the EFS system 
shall be the toll-free number posted on the TrueFiling Web site. 

The Court shall not be responsible for malfunction or errors occurring in electronic transmission or 
receipt of electronically filed documents. 
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(i)	[Service]  
An attorney’s registration with TrueFiling to participate in EFS constitutes consent to service or 
delivery of all documents by any other party in a case through the system. (California Rules of 
Court, rule 8.71.) 

(j)	[Filing	Fees]  
TrueFiling is a private vendor under contract with the Court. TrueFiling will assess vendor fees for 
each filing in accordance with the schedule posted on its Web site, as approved by the Court. E-
Filing fees will be considered recoverable costs under California Rules of Court, rule 8.278(d)(1)(D). 
TrueFiling is designated as the Court’s agent for collection of Court imposed fees where required 
for any filing, and any associated credit card or bank charges or convenience fees (California Rules 
of Court, rule 8.78; Gov. Code, § 6159). 

Should a self-represented party with a fee waiver opt to file documents electronically, that party is 
exempt from the fees and costs associated with electronic filing. The persons and entities identified 
in Government Code section 6103 also are exempt from the fees and costs associated with e-Filing. 

(k)	[Exemptions]  
Self-represented parties may, but are not required to register for electronic filing, but must comply 
with this rule and the requirements of TrueFiling if they elect to register. 

If electronic filing and/or service causes undue hardship or significant prejudice to any party, the 
party may file a motion for an exemption from the requirements of this rule. (See Cal. Rules of 
Court, rule 8.54(a)(1)&(2).) When it is not otherwise feasible for a party to convert a document to 
electronic form by scanning, imaging or other means, the document may be filed in paper form 
(California Rules of Court, rule 8.73(c)), together with a declaration setting forth the reasons that 
electronic filing was not feasible. 

(l)	[Sanctions	for	Noncompliance]  
Failure of counsel to timely register or otherwise comply with EFS filing requirements, unless 
exempted, shall subject counsel to sanctions as may be imposed by the Court. 

(Effective	May	11,	2015) 
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COURT OF APPEAL, FIFTH APPELLATE DISTRICT 

UPDATED ELECTRONIC FILING GUIDELINES 

Guidelines for submitting documents to the Court of Appeal that a party seeks to become part 

of the record on appeal. 

It has come to the court's attention that parties occasionally file a motion, application, or 

request which also includes documents the party seeks either:  to become part of the court’s 

record (such as an augmented record, supplemental brief, corrected brief, amicus curiae brief or 

any other similar document); or to be judicially noticed.   When a party electronically 

incorporates the documents they wish to be part of the record on appeal into the motion, 

application or request, this court has no way of separating the documents to become part of the 

official record or to be judicially noticed.  Therefore, the court has established the following 

guidelines for submitting such documents in electronic form.   

              To ensure that such documents are useable as electronic records, this court requests that 

the party: 

1. Electronically submit documents the party seeks to become part of the appellate 

record as a separate .pdf file at the same time as the motion, application or request. 

2. Ensure such documents are formatted in compliance with this court’s Local Rule

8(b). 

Guidelines for submitting documents over 300 pages in length.  

Notwithstanding California Rules of Court, rules 8.124(d)(1), 8.144(c)(1) and 

8.486(c)(1)(A), when submitting documents electronically, the parties may exceed the 300 page 

limit as long as the file size is 25 megabytes or smaller.  
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Formatting Guidelines 
 
The Court encourages all electronic filers to comply with the following 

guidelines for briefs, motions, appendices, writ petitions and other documents 
filed in connection with appeals or original proceedings.  

 
Pagination:  
            Number pages consecutively beginning with the cover page of the 

document, using only the Arabic numbering system, as in 1, 2, 3.  Do 
not use a separate pagination system for tables within the document.  
The page number does not need to appear on the cover page. 

 
Bookmarks: 
             

Briefs, motions and petitions:  In any document that contains a table 
of contents, the table should include an electronic bookmark for each 
heading to the corresponding heading in the text. 
A bookmark is a text link that appears in the Bookmarks Panel of 
Adobe Reader and Adobe Acrobat.  In this example, clicking on 
“INTRODUCTION” would take the reader to that part of the brief. 
 

 
 
Appendices and exhibits:   In any document that contains an index, 
including appendices and exhibits in support of writ petitions, the 
index should include an electronic bookmark from each descriptive 
document title to the first page of the corresponding document in 
the appendix or exhibits. 
 
Where appendices or exhibits are submitted in multi-part electronic 
files, each separate file should have a table or index stating the 
contents of that file.  The table or index should include the 
bookmarks as noted above.  
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Introduction 
 
This guide was created to help filers provide working electronic documents to the 
Courts of Appeal and the Supreme Court in California. While there are other 
products that can produce the same result, this guide focuses on Word (2007, 2010 
and 2013) and Adobe Acrobat Pro XI. Some of these steps may be similar in other 
programs. 
 
Be sure to check all rules with the court you are filing with to make sure you have 
met all their requirements and local rules for electronic documents. 
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I. Creating Electronic Appellate 

Briefs, Original Proceedings, 

etc. 
 
 

A. Format 

 
Check with the court’s website that you are filing your document(s) with to ensure 

that you meet their requirements or guidelines for formatting. 

 

B. Tools 
 

  Word processor 

The primary tool for creating an electronic brief or original proceeding is your word 

processor. Microsoft Word provides some helpful features that make creating an 

electronic document easier. In particular, Word’s Styles feature (see Generating 

Bookmarks below) allows you to create headings in your brief that will automatically 

create bookmarks when you convert the document as a PDF.  
 

  Adobe Acrobat Pro 

Adobe Acrobat sets the standard for creating, combining, editing, redacting and 

making PDFs searchable. Eventually you will need to do all of these things if you are 

working with electronic documents. There are other less expensive PDF software 

programs, but you will find a variety of resources to assist you with Adobe Acrobat. 

For example, Adobe hosts a free Acrobat for Legal Professionals Blog that provides 

tips and techniques for working with electronic legal documents.  

 

C. Basic Steps 

 

1. Save or convert your document from the original word 

processing document, such as Word, directly to PDF (do not 

scan the document to create a PDF). 

2. Create bookmarks1 from the Table of Contents. 

3. Redact any information that must be redacted under the rules. 

(See Redacting.) 

4. Make text-searchable. 
 

You can skip step 3 above if your document does not contain any information that 

must be redacted. 

  

1    Bookmarks are a fast and easy way to quickly navigate to different parts of a document and are 

required by the California Supreme Court and all Courts of Appeal.  
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D. Pagination 

 
Before saving/converting the document as a PDF, make sure to number the pages 

consecutively beginning with the cover page of the document, using only the Arabic 

numbering system, as in 1, 2, 3, with a number on every page.  Do not use a separate 

pagination system for tables within the document and the page number does not need 

to appear on the cover page and can be suppressed. 

 

1. Saving/Converting directly to PDF 
 

  

  Word 2007 (without Adobe Acrobat Pro installed) 

 

  Click the Microsoft Office Button in the top left hand corner of Word. 
 
 
 
 
 
 
 
 
 
 
 

   Choose Save As and PDF or XPS (see below).  
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In the dialog box that appears, click the button in the lower right hand 

corner that says Publish. 
 

 

 
  Word 2007 (with Adobe Acrobat Pro installed) 

 

  Choose Save As and Adobe PDF (see below). 
 

 

 

  When the box below appears, choose Yes. 
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  Word 2010 and 2013 

  

  Click on the File tab. 

 

 

 

  Choose Save As. 

 

     
 
  Click Browse 

 

    
 

 

  In the dialog box that appears, choose the Save as type = PDF. 
 

 

 

  Click Save. 
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  Adobe Acrobat Ribbon in Word 

 

When you install Adobe Acrobat, the installer may add Acrobat buttons or menu 

commands to Microsoft Office applications (e.g., Word, Excel, PowerPoint).  

 

The advantage of using the Acrobat Ribbon to create PDF from Word is that it will 

automatically create bookmarks for your document if you have used Word’s Styles 

feature. 
 

  

 Choose Acrobat at the top of the screen (to the right of View). 
 

 
 

 

 Click Create PDF in the menu. 

 

 
 
 In the dialog box that appears, click Save. 
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When printing a hard-copy of a document, be sure to use the PDF file 

to insure that the print exactly replicates the e-file version. Pagination 

and sentence structure may change when converting a document to a 

PDF. 

2. Create bookmarks

A bookmark is a text link that appears in the Bookmarks Panel of Adobe Reader 

and Adobe Acrobat. Readers can use the bookmarks to quickly navigate to different 

sections of a document. Make sure to include bookmarks in all electronic documents 

and be sure to use descriptive labels for your bookmarks (e.g. Trial Court Judgment, 

Court of Appeals Opinion) as illustrated below. 

Clicking on the Bookmarks Icon (left 

side of screen) opens the Bookmarks 

Panel revealing the list of bookmarks, 

as in this illustration. 

Bookmark settings 

To maximize the impact of your document, set the bookmarks to open automatically. 

While the document is open, click File > Properties > Initial View tab  

Click the Navigation tab dropdown and select Bookmarks Panel and Page 

Click OK 

Also, make sure to set the zoom settings in the bookmarks to make sure the 

bookmark view is always the same. See Adobe PDF Bookmark Zoom Settings. 

Generating bookmarks 

If you use the paragraph styles available in Word to label the headings in your 

document, when you use the built-in Acrobat ribbon to generate your PDF, your 

document will already include bookmarks to the headings in your document.  

JATS MATERIALS E-BINDER PAGE 177



 

A tutorial on Word’s Styles feature is beyond the scope of these instructions, but 

Microsoft provides a tutorial on the web. Word’s Styles feature is a tremendous time 

saver for generating bookmarks, the table of contents, and formatting your document. 
 

  Manually adding bookmarks 

 

To manually add a bookmark, in Adobe Acrobat, follow these steps: 

 

1. Click on the page where you want to create a bookmark 

2. Click the New Bookmark Icon in the Bookmarks Panel or select CTRL and B 

keys on your keyboard at the same time. 

3. In the text of the new bookmark, type the name or label that you want to give 

the bookmark.  

 

OR 

Highlight the text on the page you want to bookmark, then press the CTRL 

and B keys on your keyboard at the same time (or right click and select add 

bookmark). The bookmark will appear in the panel and the name will be the 

same as the text you highlighted. 
 

  Editing bookmarks 

 

To delete a bookmark, select the bookmark and press the delete key. 
 

To edit the name of a bookmark, 

double click on the bookmark. 

Once the bookmark text is 

highlighted, you can edit the text of 

the bookmark. Press enter when you 

are satisfied with the results. 
 
Avoid using names like Header A, 

Header B, etc. Instead, try something 

like Statement of the Case, 

Conclusion. 
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  Moving bookmarks 

 

To move bookmarks up and down in the Bookmarks Panel, left click and hold the 

text and drag the bookmark to the desired location in the Bookmarks panel. Once the 

arrow and dotted line are in the new location, release the left mouse button to drop the 

bookmark in its new location. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Nesting bookmarks 

 

Bookmarks can also be nested 

underneath other bookmarks to create 

a tiered structure of bookmarks, as in 

the illustration. Clicking on the minus 

sign next to the Argument and 

Authorities bookmarks collapses 

these bookmarks so that they are not 

visible. A plus sign then appears next 

to the Arguments and Authorities 

bookmark, which will expand the 

nested bookmarks and make them 

visible again when selected. 
 

 

To nest a bookmark underneath another bookmark, move the bookmark as described 

above. But this time, move the bookmark up and over underneath the bookmark 

where you want it nested. In other words, select the bookmark by left clicking and 

holding the mouse button down. Then move it up and to the right without releasing 

the mouse button. Release the mouse button once the bookmark appears to be 
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indented. Once you have the bookmarks the way you want them, be sure to save your 

document in order to save your changes! 

 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Redacting  

 

Redaction should be done before creating bookmarks and making the appendices text 

searchable. The steps below will remove bookmarks and text recognition.  

 

Pursuant to Cal. Rules of Court, rule 1.20, you must redact the following information 

from an appendix submitted to the court:  

 

 Social security numbers 

 Birth date  

 Home address  

 Name of any person who was a minor when the underlying suit was filed  

 Driver’s license number  

 Passport number  

 Tax identification number  

 Any similar government-issued personal identification number  

 Bank account numbers  

 Credit card numbers 

 Any other financial account number.  
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The most important thing to remember about redacting documents is to 

permanently remove the information from the document. Do not use a black 

highlighter in Adobe Acrobat to cover up the information! Highlighter marks 

can be removed by anyone with Adobe Acrobat and anyone can search the text of the 

document to find the text that is beneath the highlighter mark. 

 

If you have Adobe Acrobat Pro, you can use the redaction features of the program to 

redact documents electronically (see Redacting Using Adobe Acrobat Pro below). 

Please note that Adobe Acrobat Standard does not have redaction features. 
 

 

  Redacting using Word 
 

If you do not have Adobe Acrobat Pro, then you should edit the text of any 

document that you have in the original file (e.g., a Word document) to remove the 

information. Replace any characters that you remove with the letter x and then 

save the edited document as a new document. Here is an example: 
 

Original text document: 
 

Mike Brown’s social security number is 357-57-7372. His home 

address is 1510 Maple Avenue, New York, 201292. His credit 

card number is 2138 2912 2938 2919. 

Edited Text: 
 

Mike Brown’s social security number is xxxxxxxxxx. His home address is 

xxxx xxxxx xxxxxxx xxx xxxxx xxxxxxx. His credit card number is xxxx 

xxxx xxxx xxxx. 

 

As you can see, depending on the font you are using, editing the document in this way 

may slightly alter the layout of your document. Be sure to check the page layout to see 

if your page numbering has been altered. If you do not have Adobe Acrobat Pro and you 

only have the documents in paper format, you will need to copy the documents, redact 

them manually, and then scan the redacted documents. 
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  Redacting Using Adobe Acrobat Pro 

 

Click the Tools panel > Protection > Mark for Redaction.  

 

Select the text you want to redact. To select text, click the left button on the 

mouse and drag it across the text using the redaction tool. You can also double 

click a word to mark it for redaction. 

 

1. Place the cursor over the word marked for redaction to preview what 

the text will look like when redacted. 

2. Once you are satisfied with the appearance, choose Apply Redactions. 

 

  

 This window will appear 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

  Click OK 

 

 

 When this window appears 

 

 

 

 

 

 

 

 

   

 

  Click Yes 
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  Adobe will open the panel below and find hidden information 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   Click Remove 

 

  When this window appears 

 

 

 

 

 

 

 

 

 

   Click OK 

 

   Save the document. 
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4. Text-searchable 

 
All electronic documents must be text-searchable, in PDF (portable document format) 

while maintaining the original document formatting. If you find your PDF is not text-

searchable, follow the instructions below. 

 

Open the document in Adobe Acrobat Pro. 

 

 Click Tools > Text Recognition > In This File > OK  
 

     

 

 

 

 

 

 

 

 

 

 

 

 

 

If some text has already been rendered searchable, check the box Ignore future errors 

in document and click on OK.  When the Text Recognition process is complete, 

remember to save the document. 
 

 

NOTE: If a header, e-filing stamp or bates no. has been added to a non-searchable 

document, Acrobat will not OCR that page and you will receive the message below. 
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E. Fixing Mistakes in Adobe Acrobat Pro 
 

It is not unusual to get to the end of the process of creating an electronic brief and 

discover that you have made a typographical error. You may be able to fix some simple 

typographical errors using Adobe Acrobat. The Edit Text tool allows you to erase and 

type in a PDF as though it were a word processing document. Adobe Acrobat 

automatically recognizes the font type and size, and you can backspace to remove text 

and then retype.  

 

Select Tools > Content Editing > Edit Text & Images. Then place your 

cursor where you want to edit and type as you would with a word processor. 
 

The tool has some limitations and not all fonts are available in Adobe Acrobat. If you 

used an unusual font you may get the following message. 

 

Also, the Edit Text tool cannot reflow all of the text in your document like a word 

processor, so this tool cannot be used to retype sizeable portions of your brief. 

 

 

F. Replacing Pages 

 

If the mistake cannot be fixed with the Edit Text tool, you may be able to fix the 

error by deleting the offending page and replacing it with a corrected page. To replace 

a page, first fix the mistake in your word processing program. Then convert the 

corrected word processing document to PDF. Now Extract the corrected page from 

your corrected PDF and save it as a separate PDF document. Then Delete the page 

with the error from your original PDF and Insert the corrected page into the proper 

place in the original PDF. 

 

Click Tools > Pages > Extract or click the Page Thumbnail icon on the left, 

right click on the page(s), select extract Pages  
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Depending on the mistake, it may just be easier to start over and recombine all your 

files after fixing the error in your brief. But if you have done a lot of manual 

bookmarking and hyperlinking, replacing the page using Adobe Acrobat may be easier 

than starting all over again. 

G. Combine individual files into one PDF file 

To combine individual files into a single PDF document, follow these steps: 

Within a document in Adobe Acrobat 

Choose Create > Combine Files in to a Single PDF 

Or 
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  From the Main Menu in Adobe Acrobat 
 

  Choose Combine Files into PDF 

 

 
 

 

In the dialog box, add the individual files or folders that you want to combine into a 

single PDF.  The files can be of any format supported by Adobe Acrobat (Word, PDF, 

Excel, etc.). 

 

 
 

 

  Arrange the files in the order that you want to combine them. 

  Select Combine Files. 

  Save and name the combined document. 
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H. File Size 
 

A single PDF file may not exceed a total of 25 megabytes in size. If a filing exceeds this 

file size limitation, the TrueFiling system will not accept the document and the user 

must either (a) submit the filing in multiple parts or (b) provide the court with the 

filing in electronic format on a CD (compact disc), DVD or flash drive. Please note that 

audio files must be submitted in .wav or mp3 format and any video files must be 

submitted in .avi or mp4 format. 

 

Be sure to check all rules with the court you are filing with to make sure you have met 

all their requirements and local rules for electronic documents 
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II. Creating Electronic Appellate

Record on Appeal/Exhibits 

Appendices must comply with California Rules of Court, rule 8.124, including 

chronological and alphabetical indices. For Exhibits, see rule 8.486(b). When possible, 

use PDF files that are converted from native formats, rather than scanned documents. 

(See Saving/Converting directly to PDF.) Counsel or parties should cooperate in 

providing electronic copies of documents when requested and should check the local 

rules of the court where they will be filing to make sure all requirements for electronic 

documents have been met.

A. Chronological Index 

The chronological and alphabetical index should be converted from the word 

processing program used to create them.  

B. Pagination 

Make sure to number the pages consecutively beginning with the cover page of the 

document, using only the Arabic numbering system, as in 1, 2, 3. Every page must 

have a number.  Do not use a separate pagination system for chronological or 

alphabetical index within the document. The page number does not need to appear on 

the cover page. 

C. Scanning Documents 

Although you are prohibited from scanning your documents that are available in 

electronic format (e.g. cases, statutes, etc.), there are occasions where you will need 

to scan a document in order to include it in your appendix. For example, a trial court 

may not have electronic filing so you may have to scan a trial court order. Or maybe 

you really want to include a contract in your appendix and it is only available in 

paper form. In those situations the only solution is to scan the document. 
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You can create a PDF file directly from your scanner using Adobe Acrobat or other 

software.  When scanning, make sure that the scanner settings are: 

 

 300 dots per inch (dpi)  

 Black and white (not gray scale or color, unless scanning an image) 

 OCR (optical character recognition) 

 

A one hundred page scanned document (that does not include images) with these 

settings should be about 3.5 megabytes in size. (NOTE: File size may vary with 

certain documents.) If scanning is creating files that are too large, check the settings 

on your scanner. Most office copiers, have a menu that allows the scanner settings to 

be adjusted.  
 
If you have already adjusted the scanner settings, and the file size is still too large, 

some computer programs have the capability to reduce the file size. Adobe Acrobat 

Pro can do that (see instructions below). Make sure to do this before bookmarking 

the appendix. There are also a number of online resources that explain how to 

reduce the file size of scanned documents.  

 

  Scanning with Adobe Acrobat 
 

If you have a scanner connected to your computer that Adobe Acrobat recognizes, you 

can scan documents using Adobe Acrobat. Follow these steps: 
 

1. Insert the document into your scanner 

2. Open Adobe Acrobat 

3. In Acrobat, choose Create> PDF From Scanner 

4. Choose Black and White 
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  Preset scanning settings for Adobe Acrobat 

 

Adobe allows you to preset settings for scanning a document.  

 

 Select Create> PDF from Scanner> Configure Presets 

 

 
 
 

 

 

 

 

 

 

 

Configure your presets to scan at 300 dpi. Be sure to check Make Searchable (Run 

OCR). For standard black and white documents you do not need to move the slider to 

create a high quality scan—smaller file size is preferred. Save your settings before 

scanning. The default settings are now set and each time you choose to use the Black & 

White Document preset the document will be scanned using these settings. 
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D. Combine individual files into one PDF file 

See Combine individual files into one PDF file above. 

E. Create bookmarks for all documents contained in the 

appendix 

A bookmark is a text link that appears in the Bookmarks Panel of Adobe Acrobat.  

Some courts require bookmarks for each document that is listed in the index. Be sure 

to check the local rules of the court you are filing with to make sure you have met all 

requirements for electronic appendices.  

For documents without titles, be sure to use descriptive labels for your bookmarks. 

See Create Bookmarks in Section I. above. 

F. Redacting 

See Redacting in Section I. above 

G. Make a document searchable from any scanned or otherwise 

non-searchable material searchable by using Text 

Recognition  

Open the document in Adobe Acrobat Pro. 

Click Tools >Recognize Text> In This File > OK 
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If some text has already been rendered searchable, check the box Ignore future errors 

in document and click on OK.  When the OCR process is complete, remember to save 

the text searchable version of the document. 
 

 

NOTE: If a header, e-filing stamp or bates no. has been added to a non-searchable 

document, Acrobat will not OCR that page and you will receive the message below. 

 

 

 

 

 

 

 

 

 

 

 

H. Optimize PDFs to reduce file size 
 

Large documents or documents containing forms, photos or graphics should be saved 
as an optimized PDF to reduce file storage size.   
 

Select File and click Save As.   
 
From the Save as type dropdown menu, select PDF.   
 

From the Optimize for radio buttons, select Minimum size (publishing 
online).   

 

 

 

Click Save.  
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III. Hyperlinking 
 

 

Overview of Hyperlinking 

 

In the internet research world, hyperlinks are a standard way of “drilling down” for 

more detail or specific information. Just as all web pages contain links to other 

pages, cases downloaded from legal research services such as Westlaw or Lexis 

contain links to the cases, statutes, articles, or other sources cited within the opinion. 

The links allow immediate access by the reader to these referenced materials. 
 

Attorneys can include links to cited law and their Appendix or Clerk’s Transcript and 

Reporter’s transcript, adding another level of persuasion to their writing. Hyperlinks 

in briefs and other court filings provide quick, easy, and pinpoint access to particular 

sections of a case, or to specific filings in the court’s record. The attorney can thereby 

highlight the precise issue presented, and the specific evidence and controlling or 

persuasive law the court should consider. 
 

Though it is not required, rather preferred, hyperlinks in court filings are very 

beneficial for court chambers. Court submissions which include links to relevant 

case law and case filings are easy for chambers staff to review. The attorneys’ 

arguments can be immediately verified in the context of the relevant law. The 

justice or judicial clerk is able to read the text of the cited case law on one screen 

while reading the attorney’s brief on the other. And if a brief contains links to 

referenced exhibits, and even to specific pages within those exhibits, the judge or 

judicial clerk can access the relevant evidence without having to navigate through 

the paper record. Particularly when dealing with large and complex cases, links save 

chambers considerable time and effort. Links make it easy for the court to verify – 

and adopt – the positions taken by an advocate. 
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Types of Permissible Hyperlinks 
 

Subject to the court’s local rules, the following types of hyperlinks are typically allowed 
in court documents. 

 
 

Internal Links For example, the Table of Contents located at 

the beginning of this Guide. 

Links to attachments 

and exhibits being 

filed with your brief 

 

Note:  Evidence must be filed of record. A hyperlink 

to a public website where evidence can be found is 

not a substitute for filing evidence in support of a 

motion. 

Links to case and 

statute citations 
 

 
 

Note:  Unless a cited case 

cannot reasonably be 

found from a public 

source, it is not necessary 

to attach copies of cases 

or statutes to your brief. 

For example: 
 

Westlaw, 
 

 
 

Lexis, 

 
 
or court websites. 
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Creating a Hyperlinked Table of Contents 
 

A table of contents in a Word document can include internal hyperlinks for 

navigating the document. When the document is converted to PDF format, these 

links will become bookmarks in the PDF document. Note that the Table of Contents 

is different from the Bookmarks that are required in the PDF version. 
 

Although there are several methods for creating a table of contents in 

Word, the one most useful to attorneys (and discussed below), is to create the 

document, include any headings as you write, and then: 

 

• Mark and format the headings to be included in the table of contents; 

• Generate and insert the table of contents; and 

• Edit as needed. 
 

Marking and Formatting Table of Contents Entries 
To mark and format entries to be included in the table of contents using Microsoft 

Word: 
 
 

STEP ACTION 
 

1 
Create your document, inserting all headings with the format of 

your choice. 
 

2 
Using your cursor, scroll over and 

select the heading you want to 

include in the table of contents. 
 
 

3 
From the 

Styles section 

on your Home 

tab, 
 
 
 

Click the down arrow in the right 

lower corner. 
 
 
 

A drop down list will appear. 
 
 

 

Note: There are pre-formatted Heading Styles 

available in MS Word, but only 2 may be visible in 

your styles drop-down menu.  Additional heading 

options will appear, as you make your selections.  
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If… Then… 

You want the 

text of the 

table of 

contents 

entries to 

match the 

headings 

already 

created 

within your 

document: 

 
Use your cursor to select the heading to be included 

in the table of contents. 
 

  
From the Styles list, Right-click the heading level 

you wish to apply. In the box that appears, select: 
 
Update Heading [x] to Match Selection. 

 
Continue until a heading style has been applied to 

all heading levels within your brief. 

You want to: 
 
Set a 

standard 

format (e.g. 

font, font color, 

bold, etc.), for 

all headings 

and table of 

contents 

entries created 

with your 

Word program 
 
 

Or 
 
 
Change 

the 

heading 

format in 

the brief 

already 

created: 

 
From the Styles list: 

 

Right-Click the 

heading level you wish 

to modify. 
 

In the box that appears, 

select Modify to open 

the Modify Style box. 
 

Choose text: 
 

• font 
 

• font size 
 

• appearance 
 

• color 
 

• justification 
 

• line spacing 
 
 

Save settings for: 

• only in this document, or 

• all documents created using your standard 

template 

• Add to Quick Style List. 
 

Click OK. 

Scroll through your document.  For each heading, select the heading text with the 
cursor, then click the heading style to be applied. 
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Generating and Inserting the Table of Contents 
 To add the Table of Contents to your document: 

 

 

STEP ACTION 
 

Place your cursor in 

the document at the 

location you want to 

insert the table of 

contents. 
 

Add a title for the 

Table of 

Contents. 
 

Enter a few hard 

returns. 
 

Control + Enter to 

insert a page break. 
 

 

 

Place your cursor 

where the table of 

contents entries 

should begin. 
 

 

From the 
 

References tab of 

your Word ribbon, 
 

Select 
 

Table of Contents, 

and from the menu 

that appears, 
 

Select: 
 

Insert Table of 

Contents. 
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Make selections for the 

appearance of the table of 

contents. 
 

Click OK. 
 

Note:  If your table has 

more than three levels, 

you must set Show levels 

to the correct number. 
 

Note:  The “Use 

hyperlinks instead of page 

numbers” must be checked 

or the table of contents 

will not have active links 

upon conversion to PDF. 
 

 

 

The Table of Contents, 

with active section links, 

will be inserted into your 

document. 
 

Note:  You can manually 

modify the page numbers 

to appear as other links in 

your document,  

blue and underlined). 
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Editing the Table of Contents (if needed) 

 
Inserting the Table of Contents may result in page break changes. For example, 
hard page breaks or extra lines that were added during drafting to adjust the 
overall look of the document may no longer be needed, or some may now need to be 
added. 

 

If the brief was modified after the table of contents was inserted: 
 

 

STEP 
 

ACTION 
 

From the reference tab on 

the Word ribbon, select 

Update Table. 

 

 
 

 

Select 
 

Update page numbers 

only. Click OK. 

Note: If you have added or 

changed a heading, choose 

Update entire table. 

 

 
 

 

 

 

When the entire document is complete, using MS Word, Save the document as a 

PDF or Create PDF. 
 

Note:  Do not Print to PDF.  All active links in your Word document 

become inactive in PDFs created using Print to PDF. 
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Formatting the Appearance of the Links Inserted 
 
Before inserting links into a document, you may choose how those links will 
appear in the final document. For example, do you want them to appear: 

blue and underlined, 

bold and black, 

black and italicized, 

or 

some other appearance? 
 

To select the appearance of the links in your document: 
 

STEP ACTION 
 

1 On the Home tab, 

click on the tiny arrow under 

Changes Styles. 
 
 

 

2 A drop down menu will appear. 

Scroll down until you see Hyperlink. 

Right-click on Hyperlink, and from 

the choices that appear, select Modify. 
 

 
 
 

 

 

 

3 A Modify Style box 

will appear. 
 

Change the color, font, and 

underlining, etc. for 

hyperlinks. 
 

Note:  Choose a specific font 

and font size for the linked 

text only if the linked text font 

and font size should appear 

different from that of the 

document text.  Otherwise, 

leave the font and font size 

selections blank. 
 

Click OK. 
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Adding Links to Attachments 
 

STEP ACTION 

1 
 

Save all the attachment documents you will cite in your brief into a 

single folder in your computer. The documents must be in PDF 

format. Be sure the names of the files do not contain special 

characters, such as apostrophes or ampersands, as these will break 

the hyperlinking process. 

2 
 

While drafting your brief, include the citations to the documents 

saved in your computer. 

3 
 

Using your cursor, select the text to which a link will be added. 
 

 
 

4 
 

On the Insert 

ribbon, select  

Hyperlink. 

5 
 

In the Insert Hyperlink dialog box: 
 

• Navigate to cited 

file saved on 

your computer; 

• Select the file; and 

• Click OK. 
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6 A link to the file will be added to the text. If you hover over the 

link with your cursor, you will see the link address. 
 

 
 
 
 
 
 

Add links to all the citations in your brief accordingly. 
 

Note: Specific page links can be added by following the 

directions in the previous section. Use the PDF page number, 

not a Bates number or footer page number, for the citation. 

 

 

Automated Links to Legal Citations 
 

Links to legal citations can be added manually or, assuming the software is 

compatible with your computer and word processing software, by using automated 

linking software available through Westlaw or Lexis. 
 

 

Access to Linking Software 

Tool Cost URL 

Westlaw InsertLinks Must purchase a West 

BriefTools 

subscription. 

Estimated cost: 

$100/month for small 

firms; 

$300 to 500/month for 

larger firms (10 licenses) 

http://legalsolutions.thomson

re uters.com/law- 

products/solutions/brief- 

tools?searchterms=brief+tool 

Lexis for 

Microsoft Office 

This Lexis software product 

will add links for research 

and drafting purposes, but 

those links are lost upon 

conversion to PDF. Lexis is 

investigating the issue. 

http://www.lexisnexis.com/en
- us/products/lexis-for-
microsoft- office.page 
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Linking Software—Compatibility Information 
The following graph outlines the compatibility of Shepard’s Links 2008, 
West InsertLinks, and Lexis Links for Microsoft Office for inserting links into 
MS Word and WordPerfect documents with a Windows XP (SP3) 2GB 
Memory, Windows Vista (SP2) 4GB Memory, or Windows 7 – 4GB Memory 
computer.* 

 

Shepard’s 

Links 

2008 

Lexis for 

Microsoft 

Office 

West 

InsertLin

ks 

MS Word 2010 X** X*** 
 

MS Word 2007 X** X*** 
 

MS Word 2003 X X*** 
 

MS Word 2000 X 
 

WordPerfect X6**** 
 

WordPerfect X4 – X5 X 
 

WordPerfect X3 X X 
 

WordPerfect 10 – 12 X 
 

* The West and Lexis linking software programs cannot be used on Apple 

computers. Moreover, although Shepard’s Links was not designed to operate on 

Windows Vista and Windows 7 (as reflected in the Lexis literature), it is working 

on these computer systems. 
 

** Lexis for Microsoft Office is being developed and tested. However, in its current 

stage of development, any links added by Lexis for Microsoft Office are being 

stripped out upon conversion to PDF.  Lexis is investigating this issue. 
 

*** Westlaw product information states InsertLinks is compatible with both 32- and 

64-bit Microsoft Word. However, while it works well with 32-bit Word, InsertLinks 

is not fully compatible or useful with 64-bit Word. 
 

**** West currently has no linking software compatible with WordPerfect X6. 

West indicates it may develop and release this product during the summer of 2013. 
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Westlaw InsertLinks 
InsertLinks is a Westlaw computer software program which scans Microsoft 

Word or Corel WordPerfect1 documents to locate legal citations, and then 
automatically inserts hyperlinks to the Westlaw internet address (url) for those 
citations into the word processing document. 

Installing West InsertLinks 
InsertLinks is part of the West BriefTools suite, and a 
BriefTools subscription is required in order to use this 
software. 

• The current West BriefTools product is Version 2.7.2039,

which was updated on December 10, 2012.

Using West InsertLinks 
Once InsertLinks software is installed, Westlaw links can be 

installed automatically in Microsoft Word documents using the 

following steps: 

STEP ACTION 

1 With the Microsoft Word document to which you are 

adding links open on your screen: 

Select the Westlaw Solutions tab on the Word ribbon. 

2 The West BriefTools options will open. 

Select InsertLinks. 

1 Currently, InsertLinks is not compatible with, and cannot be used for, automatically 

inserting links into WordPerfect X6 documents. It does, however, work with prior versions 

of WordPerfect. 
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STEP ACTION 
 

3 The InsertLinks software will begin searching the 

document for citations and inserting the appropriate links. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The box depicted above will disappear when the process is 

complete and all links are installed. 
 

 

 
 

 
 
 
 

Manually Inserting Hyperlinks 
 

As previously described, hyperlinks to documents filed can be manually 

added to a document about to be filed. It is also possible to manually create links 

to documents available through commercial legal websites (e.g., Lexis or 

Westlaw), and those posted on the court’s website (Local Rules). 
 

Manually adding links can be labor intensive if the document is long, but 

the process is not difficult. And even if you are primarily using software to add 

links to a document, understanding the underlying mechanics of hyperlinking 

within WordPerfect and Word documents is helpful and may be necessary if, for 

example, you need to make corrections to the automatically created links. 
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Manually Creating Links to Online Research Resources 
 
The process for manually adding links to Westlaw, Lexis, Google Scholar, or any 
other online research resource (LoisLaw, FastCase, etc.,) is the same. 

 
STEP ACTION 

 

1 In the brief, use your cursor to select the citation to which 

you are adding a link. 
 

 

 

 

2 Sign into the legal research website and open the cited 

document. Select the url address for the document. 

Note: When using this method, if the link on the website 

changes, the link in the document may not work. 

Right-click, and Copy the address. See below: 
 

 

 

 

 

 

 

 

OR 

When using Lexis Advance, select Actions > Link to this page. 

This will use a static link, which should always work. 

 

 
 

 

Note:  Check your local rules for any authority or limitations on 

the legal research websites to which links are permitted. 

Note:  Some attorneys have reported difficulty using this method to 

insert links to Lexis research. 
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 STEP ACTION 

3 a 
 

Select the Insert ribbon, then select Hyperlink. An 

Insert Hyperlink dialog box will appear. 
 

 
 

Note: The text you selected will automatically appear in the 

“Text to display” line. 
 

b 
 

Place your cursor in the Address box of the Insert 

Hyperlink dialog box. Right-click. From the drop-down 

that appears, select Paste. 
 

 
 

Click OK. 
 

c 
The link to the citation will be added in your brief. 
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Special thanks is given to Blake A. Hawthorne, Clerk of the Texas 

Supreme Court and the Texas Supreme Court for sharing their Guide to 

Creating Electronic Appellate Briefs. 
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Supreme Court Rules Regarding Electronic Filing 1 

Amended and effective May 1, 2018 2 

 3 

Rule 1. Application; electronic filing system. 4 

These rules govern electronic filing in the Supreme Court under California Rules of Court, rules 8.70 – 8.79. 5 

The court’s electronic filing system (EFS) is operated by ImageSoft TrueFiling (TrueFiling).   6 

 7 

 8 

Rule 2. Documents subject to electronic filing 9 

Rules 3 and 4 identify the documents that must or may be filed electronically in the Supreme Court. No 10 

document other than those identified in rules 3 and 4 may be filed electronically in the Supreme Court. 11 

 12 

 13 

Rule 3. Mandatory electronic filing 14 

 15 

(a) Documents that attorneys must file electronically 16 

Pursuant to California Rules of Court, rule 8.71, effective September 1, 2017, unless the court grants a 17 

motion for an excuse under rule 6, all attorneys representing a party in a matter before the court must file 18 

the documents listed in this subdivision electronically through the court’s EFS. 19 

 20 

(1) Documents in proceedings under rules 8.495-8.498, 8.500-8.508, 9.13, and 9.60   21 

All documents filed before the court issues its decision to grant or deny review, including: 22 

 23 

(A) Petitions for review; answers, replies; 24 

 25 

(B) Applications to permit the filing of a petition, answer, reply, or attachment that exceeds the 26 

length limits set by California Rules of Court, rule 8.504(d); 27 

 28 

(C) Applications to extend the time to file an answer or reply; 29 

 30 

(D) Motions for relief from default for failure to timely file a petition, answer, or reply;  31 

 32 

(E)  All other applications and motions in these proceedings filed before the court issues its 33 

decision to grant or deny review; and 34 

 35 

(F) Any correspondence filed in connection with the documents in (A) – (E). 36 

 37 

(G) Amicus curiae letters under California Rules of Court, rule 8.500(g) and requests for 38 

depublication and related documents under California Rules of Court, rule 8.1125. may be 39 

filed electronically on a voluntary basis.  (See Rule 4.) 40 

 41 

 (2) Documents in proceedings under rules 8.380-8.385 42 

 All documents filed before the court issues an order to show cause or its ruling on the petition, 43 

including: 44 

 45 

(A) Petitions for writ of habeas corpus; informal responses, replies; 46 

 47 
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(B) Applications to permit the filing of a petition, informal response, reply, or attachment that 1 

exceeds the length limits set by California Rules of Court, rule 8.204(c); 2 

 3 

(C) Applications to extend the time to file an informal response or reply; 4 

 5 

(D) Motions for relief from default for failure to timely file an informal response, or reply;  6 

 7 

(E)  All other applications and motions in these proceedings filed before the court issues an order 8 

to show cause or its ruling on the petition; and 9 

 10 

(F) Any correspondence filed in connection with the documents in (A) – (E). 11 

 12 

(3) Documents in proceedings under rules 8.485-8.486, and 9.13 13 

 All documents filed before the court issues an alternative writ or its ruling on the petition, 14 

including: 15 

 16 

(A) Petitions; preliminary responses, replies, and accusations against an attorney; 17 

 18 

(B) Applications to permit the filing of a petition, preliminary response, reply, or attachment that 19 

exceeds the length limits set by California Rules of Court, rule 8.204(c); 20 

 21 

(C) Applications to extend the time to file a preliminary response or reply; 22 

 23 

(D) Motions for relief from default for failure to timely file a preliminary response, reply, or 24 

accusation against an attorney;  25 

 26 

(E)  All other applications and motions in these proceedings filed before the court issues an 27 

alternative writ or its ruling on the petition; and 28 

 29 

(F) Any correspondence filed in connection with the documents in (A) – (E). 30 

 31 

 32 

(4) Documents in matters arising from a judgment of death 33 

All documents filed in these matters. For purposes of this subdivision: 34 

 35 

(A) Matters arising from a judgment of death include: 36 

 37 

(i) Automatic appeals under California Rules of Court, rules 8.600-8.642;  38 

 39 

(ii) Habeas corpus proceedings in the court under California Rules of Court, rules 8.380-40 

8.388 that involve a challenge to the validity of the petitioner’s death judgment, 41 

including proceedings before any referee appointed by the court to conduct a hearing 42 

following the court’s issuance of an order to show cause; and;  43 

 44 

(ii) Other original writ proceedings in the court under California Rules of Court, rules 45 

8.485-8.493 that relate to an automatic appeal or a habeas corpus proceeding 46 

challenging the validity of the death judgment, including proceedings on petitions for a 47 

writ of mandate under Penal Code section 1405, subdivision (k).   48 
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 1 

(B) Matters arising from a judgment of death do not include: 2 

 3 

(i) Habeas corpus proceedings on petitions challenging only a capital inmate’s conditions 4 

of confinement; and 5 

 6 

(ii) Proceedings under California Rules of Court, rules 8.500-8.552 that relate to an 7 

automatic appeal or a habeas corpus proceeding challenging the validity of the death 8 

judgment, including petitions for review from lower court decisions regarding Penal 9 

Code section 1054.9 motions. These proceedings are governed by subdivision (a)(1) of 10 

this rule. 11 

 12 

(C) A superior court judge who is appointed by the court as a referee in a proceeding under 13 

(A)(ii) is not considered a trial court for purposes of exemption from mandatory e-filing 14 

under California Rules of Court, rule 8.71(c).  15 

 16 

(3) Other documents on order of the court 17 

Any other document on order of the court. 18 

 19 

(b) Application to new and pending cases 20 

Electronic filing of the documents listed in (a) is mandatory as of September 1, 2017, including 21 

documents filed in cases commenced before that date. 22 

Rule 4. Voluntary electronic filing 23 

 24 

(a) Individuals or entities exempt from mandatory electronic filing 25 

Pursuant to California Rules of Court, rule 8.71(b) and (c), electronic filing is voluntary for: 26 

 27 

(1) Self-represented litigants; and 28 

 29 

(2) Trial courts. 30 

 31 

(b) Amicus curiae letters and requests for depublication 32 

Amicus curiae letters under California Rules of Court, rule 8.500(g) and requests for depublication and 33 

related documents under California Rules of Court, rule 8.1125 may be filed electronically on a voluntary 34 

basis. 35 

 36 

 37 

Rule 5. Submission of paper copies of electronically filed documents 38 

 39 

(a) Documents in proceedings under rules 8.380-8.385, 8.485-8.486, 8.495-8.498, 8.500-8.508, 9.13, and 40 

9.60   41 

Unless otherwise ordered by the court: 42 

 43 

(1) For each electronically filed document in these proceedings, the filer must also submit to the court 44 

one unbound paper copy of the document.   45 

 46 

(2) The paper copy must be mailed, delivered to a common carrier, or delivered to the court within two 47 

court days after the document is filed electronically with the court.  If the filing requests an 48 
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immediate stay, the paper copy must be delivered to court by the close of business the next court 1 

day after the document is filed electronically.   2 

 3 

(b) Documents in matters arising from a judgment of death 4 

Unless otherwise ordered by the court: 5 

 6 

(1) For each electronically filed document in these matters, the filer must also submit to the court one 7 

unbound paper copy of the document.  8 

 9 

(2) The paper copy must be mailed, delivered to a common carrier, or delivered to the court within two 10 

court days after the document is filed electronically with the court. 11 

 12 

 13 

Rule 6. Excuse from electronic filing 14 

 15 

(a) Motion requesting excuse 16 

A party wanting to be excused from the requirement to file a document electronically must file a motion 17 

in the court requesting to be excused. The motion must comply with California Rules of Court, rule 8.54 18 

and must specify whether the party is requesting to be excused from electronically filing all documents or 19 

only a particular document or documents. 20 

 21 

(b) Grounds for excuse 22 

Pursuant to California Rules of Court, rule 8.71(d), the court will grant an excuse on a satisfactory 23 

showing that: 24 

 25 

(1) The party will suffer undue hardship if required to file electronically; 26 

 27 

(2) The party will suffer significant prejudice if required to file electronically; or  28 

 29 

(3) It is not feasible for the party to convert a particular document to electronic form by scanning, 30 

imaging, or another means.  31 

 32 

 33 

Rule 7. Registration of electronic filers 34 

 35 

(a) Obligation to register  36 

Unless the court excuses the filer from this obligation under rule 6, every filer who is required or 37 

voluntarily chooses to file a document electronically under these rules must register as a TrueFiling user 38 

and obtain a username and password for access to TrueFiling. Registration with and access to the EFS is 39 

through the TrueFiling website at https://www.truefiling.com. 40 

 41 

(b) Registered users’ responsibilities  42 

A registered TrueFiling user is responsible for all documents filed under the user’s registered username 43 

and password. The registered user must also comply with the requirements of California Rules of Court, 44 

rule 8.32 regarding the duty to provide address and other contact information, and notice of any changes. 45 

 46 

 47 
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Rule 8. Signatures 1 

Use of a registered TrueFiling user’s username and password to electronically file a document is the equivalent 2 

of placing the registered user’s electronic signature on the document. 3 

 4 

 5 

Rule 9. Service 6 

 7 

(a) Electronic service 8 

 In addition to the ways identified in California Rules of Court, rule 8.78 that a recipient may agree to 9 

 accept electronic service, a recipient is deemed to have agreed to electronic service in a matter before 10 

this  court if the recipient agreed to electronic service in the same matter in the Court of Appeal. 11 

 12 

(b) Service by the court 13 

Documents prepared by the court will be served on EFS users through the EFS or by electronic 14 

notification. 15 

 16 

(c) Service of paper copies 17 

When service of a document is required to be made on a person or entity that has not consented to 18 

electronic service, the server must comply with California Rules of Court, rule 8.25 regarding service of 19 

paper copies. 20 

 21 

 22 

Rule 10. Format and size of electronically filed documents 23 

 24 

(a) Format 25 

 26 

(1) Text searchable format  27 

All documents filed electronically must be in text-searchable PDF (portable document format), or 28 

other searchable format approved by the court, while maintaining original document formatting. If 29 

an electronic filer must file a document the filer possesses only in paper format, the filer must 30 

convert the document to an electronic document that complies with this rule by scanning or other 31 

means. It is the filer’s responsibility to ensure that any document filed is complete and readable. 32 

Except as otherwise specified in this rule, electronically filed documents must comply with the 33 

content and form requirements of the California Rules of Court applicable to the particular 34 

document, with the exception of those provisions dealing exclusively with requirements for paper 35 

documents. 36 

 37 

(2) Pagination  38 

The page numbering of document filed electronically must comply with California Rules of Court, 39 

rule 8.74(b)(3).  40 

 41 

(3) Electronic Bookmarks 42 

Each document must include in the bookmarks panel of the electronic document a descriptive link 43 

(hereafter referred to as an electronic bookmark), to each heading, subheading and to the first page 44 

of any component of the document, including any table of contents, table of authorities, petition, 45 

verification, points and authorities, declaration, certificate of word count, certificate of interested 46 

entities or persons, proof of service, tab, exhibit, or attachment. Each electronic bookmark to a tab, 47 
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exhibit, or attachment must include the letter or number of the tab, exhibit, or attachment and a 1 

description of the tab, exhibit, or attachment. 2 

 3 

(b) Size 4 

 5 

(1) An electronic filing may not be larger than 25 megabytes. This rule does not change the length 6 

limitations established by the California Rules of Court for petitions, answers, replies, briefs or any 7 

other document filed in the court. 8 

 9 

(2) If a document exceeds the size limitation in (1), a party must submit the document in multiple files. 10 

 11 

(A) These files must be paginated consecutively across all files in the document, including the 12 

cover pages required by (B). 13 

 14 

(B) Each file must have a cover page that includes the following information: 15 

 16 

(i) The total number of files constituting document;  17 

 18 

(ii) The number of this file within the document;  19 

 20 

(iii) The total number of pages in the document; and  21 

 22 

(iv) The page numbers of the document contained in this file.  23 

 24 

(C) The cover pages required by (B) must be included in the paper copies of the document 25 

submitted to the court under rule 5. 26 

 27 

 28 

Rule 11. Privacy Protection  29 

 30 

(a) Personal Identifiers 31 

Electronic filers must comply with California Rules of Court, rule 1.201 regarding exclusion or redaction 32 

of personal identifiers from all documents filed with the court. Neither TrueFiling nor the Clerk of the 33 

Court has any responsibility to review documents for compliance with these requirements. 34 

 35 

(b) Sealed and Confidential Records 36 

Electronic filers must comply with California Rules of Court, rules 8.45-8.47 regarding sealed and 37 

confidential records, with the exception of those requirments exclusively applicable to paper filings. 38 

 39 

 40 

Rule 12. Fees 41 

 42 

(a) Collection of filing fees 43 

For electronic filings, TrueFiling is designated as the court’s agent for collection of filing fees required by 44 

law and any associated credit card or bank charges or convenience fees.  45 

 46 
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(b) Vendor fees 1 

Pursuant to California Rules of Court, rule 8.73 and TrueFiling’s contract with the court, in addition the 2 

filing fees required by law, TrueFiling will assess fees for each electronic filing in accordance with the 3 

schedule posted on the TrueFiling Web site, as approved by the court. These fees will be considered 4 

recoverable costs under rule 8.278(d)(1)(D).  5 

 6 

(c) Exemption from vendor fees 7 

The following are exempt from the fees charged for electronic filing under (b): 8 

 9 

(1) Parties with fee waivers 10 

A party who has been granted a fee waiver by the court who chooses to file documents 11 

electronically.  12 

 13 

(2) Government officers and entities 14 

The persons and entities identified in Government Code section 6103. 15 

 16 

 17 

Rule 13. Technical Failure of Electronic Filing System 18 

 19 

The court is not responsible for malfunctions or errors occurring in the electronic transmission or receipt of 20 

electronically filed documents. The initial point of contact for anyone experiencing difficulty with TrueFiling is 21 

the toll-free telephone number posted on the TrueFiling Web site. California Rules of Court, rule 8.77, governs 22 

if a filer fails to meet a filing deadline imposed by court order, rule, or statute because of a failure at any point 23 

in the electronic transmission and receipt of a document. A motion under California Rules of Court, rule 8.77(d) 24 

to accept the document as timely filed must comply with rule 8.54. 25 

 26 
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Adobe PDF Bookmark Zoom Settings 


PROBLEM: 


When a PDF is submitted with bookmarks, the bookmarks can contain custom/specific document zoom 


settings that change the zoom percentage of the document whenever a bookmark is clicked.  When a 


user changes the zoom back to their preferred value, upon clicking the same bookmark or any other 


bookmark, the view changes to the zoom setting specified in the properties of each individual 


bookmark. 


Example of problem from “viewer’s” perspective: 


1. Open PDF document (the document opens with default zoom settings that the viewer has set in


Adobe Reader or Adobe Acrobat Pro).  In this case, the viewer has 150% set as their default


zoom setting for all documents when opened.


2. Upon clicking on a bookmark, the document zoom setting changes to the specific zoom setting


embedded in the properties of the individual bookmark.  In this example, the bookmark has a


zoom setting of “Fit Page” which equates to 85.4% on the monitor/resolution used to create this


help document.  You will see this setting later in the document, but the image below shows how


the percentage changes from 150% to 85.4% when clicking on the bookmark.
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3. If the viewer elects to then zoom back out/in depending on their preference, upon clicking the


same bookmark or another bookmark, the zoom once again changes to what is set in the


properties of the bookmark.  In other words, the problem continues to repeat itself throughout


the document when clicking on various bookmarks.


CAUSE: 


Adobe bookmarks (each individual bookmark) have a zoom setting in “Properties”.  Some creators of 


Adobe PDF documents (either intentional or non-intentional) or by Adobe Acrobat’s default set a 


specific zoom setting for each bookmark (e.g. “Fit Page”).   


One can see this setting (using Adobe Acrobat) by “right-clicking” on a single bookmark and selecting 


“Properties”. 







1DCA – 12/2015 


Click on the “Actions” tab and you can then see the customized/specific zoom level for that specific 


bookmark. 
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Clicking the “Edit” button allows the PDF document creator to select a different zoom level. 
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The required setting for all PDF documents filed with or transmitted to the Courts of Appeal and the 


Supreme Court is “Inherit Zoom” which allows for each bookmark to use the same zoom setting set by 


the viewer. 


Viewers of documents prefer to have a PDF document display based on their own zoom/view setting 


that they can select just once in Adobe Reader or Adobe Acrobat, which applies to any document the 


viewer opens. 


RESOLUTION: 


When creating a PDF document, once all bookmarks have been created, perform the following steps to 


change the zoom setting for each bookmark: 


1. In Adobe Acrobat, “right-click” the first bookmark and select “Properties” as shown above


2. Click on the “Actions” tab


3. Click the “Edit” button


4. Change the “Zoom” setting to “Inherit Zoom”


5. Click OK


6. Repeat for ALL additional bookmarks


NOTE:  The other option is that this option be selected during the creation of each individual bookmark 


rather than going back and editing each bookmark.  It’s a matter of preference for the PDF creator. 


OTHER: 


https://forums.adobe.com/thread/1339241?start=0&tstart=0 



https://forums.adobe.com/thread/1339241?start=0&tstart=0





